
BN68-01981D-01

LCD TV
user manual

imagine the possibilities
Thank you for purchasing this Samsung product.
To receive more complete service, please register 
your product at

www.samsung.com/register

Model                         Serial No.                       

Contact SAMSUNG WORLDWIDE
If you have any questions or comments relating to Samsung products, please contact the SAMSUNG customer care centre. 

Country Customer Care Centre Web Site
EIRE 0818 717 100 www.samsung.com/ie
U.K 0845 SAMSUNG (7267864) www.samsung.com/uk

BN68-01981D-X0.indb   1 2009-03-02   �� 5:46:17

Downloaded From TV-Manual.com Manuals

http://www.tv-manual.com


Precautions When Displaying a Still Image
A still image may cause permanent damage to the TV screen.
WARNINGS:
Image retention, commonly known as screen burn-in, can occur on most types of television if the same image is displayed 
continuously. The most common causes of image retention are logos that remain stationary on the TV screen. These logos are 
common on many programmes received via a Setop Box.
To reduce this risk, avoid displaying still images for long durations and lower the brightness or contrast settings to decrease 
the intensity of the picture. Extended viewing of movies and programs in aspect ratios that are different from the aspect ratio 
of the TV may cause image retention. Always endeavour to avoid black borders top or bottom by using the zoom function. This 
will help eliminate the black borders and fit the picture to the entire area of the screen. Using a video game console may cause 
image retention and is not recommended. When using a PC input, avoid displaying still images for long durations and reduce the 
brightness or contrast settings to decrease the intensity of the picture.
IMPORTANT:
Image retention issues are not covered by your Samsung® warranty.

Digital TV (DVB-T) Notice
1.	 FUNCTIONALITIES RELATED TO DIGITAL TV (DVB) ARE ONLY AVAILABLE IN COUNTRIES OR AREAS WHERE DVBT 

(MPEG2 AND MPEG4 AVC) DIGITAL TERRESTRIAL SIGNALS ARE BROADCAST. DVB-T is the European consortium 
standard for the broadcast transmission of digital terrestrial television. Please check with your local dealer about the 
availability of DVB-T service in your area.

2.	 Although this TV set meets the current DVB-T standards as of [August, 2008], compatibility with future DVB-T digital terrestrial 
broadcast cannot be guaranteed.

3.	 Some Digital TV functions may not be available or operate correctly in some countries or regions.
4.	 For more information, please contact your local SAMSUNG customer care centre.

Digital TV (DVB-T) Notice
1. 	 FUNCTIONALITIES RELATED TO DIGITAL TV (DVB) ARE ONLY AVAILABLE IN COUNTRIES OR AREAS WHERE DVB-T 

(MPEG2 AND MPEG4 AVC) DIGITAL TERRESTRIAL SIGNALS ARE BROADCAST. DVB-T is the European consortium 
standard for the broadcast transmission of digital terrestrial television. Please check with your local dealer about the 
availability of DVB-T service in your area.

2. 	 Although this TV set meets the current DVB-T standards as of [August, 2008], compatibility with future DVB-T digital terrestrial 
broadcast cannot be guaranteed.

3. 	 Some Digital TV functions may not be available or operate correctly in some countries or regions.
4. 	 For more information, please contact your local SAMSUNG customer care centre.

Precautions When Displaying a Still Image 
A still image may cause permanent damage to the TV screen

Do not display a still image and partially still on the LCD panel for more than 2 hours as it can cause screen image retention. 
This image retention is also known as “screen burn”. To avoid such image retention, reduce the degree of brightness and 
contrast of the screen when displaying a still image.

Watching the LCD TV in 4:3 format for a long period of time may leave traces of borders displayed on the 
left, right and centre of the screen caused by the difference of light emission on the screen. Playing a DVD or 
a game console may cause a similar effect to the screen. Damages caused by the above effect are not 
covered by the Warranty.

Displaying still images from Video games and PC for longer than a certain period of time may produce partial after-images. To 
prevent this effect, reduce the ‘brightness’ and ‘contrast’ when displaying still images.  

© 2009 Samsung Electronics Co., Ltd. All rights reserved.
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GENERAL INFORMATION

Figures and illustrations in this User Manual are provided for reference only and may differ from actual product appearance. 
Product design and specifications may be changed without notice in order to enhance product performance.

Viewing the Control Panel

The product colour and shape may vary depending on the model.
You can use a button by pressing the side panel buttons.

1	 SOURCE E: Toggles between all the available input sources. In the on-screen menu, use this button as you would use the 
ENTERE button on the remote control.

2	 MENU: Press to see an on-screen menu of your TV’s features.
3	 Y: Press to increase or decrease the volume. 

In the on-screen menu, use the Y buttons as you would use the ◄ and ► buttons on the remote control.
4	 Z : Press to change channels. In the on-screen menu, use the Z buttons as you would use the ▼ and ▲ 

buttons on the remote control.
5	 P (POWER): Press to turn the TV on and off.
6	 REMOTE CONTROL SENSOR: Aim the remote control towards this spot on the TV.
7	 POWER INDICATOR: Blinks and turns off when the power is on and lights up in stand-by mode.
8	 SPEAKERS

Accessories

(M4 X L16) (M4 X L18)

Remote Control &  
Batteries (AAA x 2) Power Cord Cover-Bottom Stand Screw X 4 Stand Screw X 3 

(32inch model only) Cleaning Cloth

Owner’s Instructions●

Please make sure the following items are included with your LCD TV. If any items are missing, contact your dealer.
The items colour and shape may vary depending on the model. 
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Viewing the Connection Panel

The product colour and shape may vary depending on the model.
Whenever you connect an external device to your TV, make sure that power on the unit is turned off. 
When connecting an external device, match the colour of the connection terminal to the cable.

1	 DIGITAL AUDIO OUT (OPTICAL)
Connects to a Digital Audio component such as a Home theatre receiver.
When the HDMI IN jacks are connected, the DIGITAL AUDIO OUT (OPTICAL) jack on the TV outputs 2 channel audio 
only. If you want to hear 5.1 channel audio, connect the Optical jack on the DVD / Blu-ray player or Cable / Satellite Box 
directly to an Amplifier or Home Theatre, not the TV.

2	 PC
Connect to the video output jack on your PC.

3	 PC / DVI AUDIO IN
Connect to the audio output jack on your PC.
DVI audio outputs for external devices.

4	 ANT IN
Connects to an antenna or cable TV system. 

5	 AUDIO OUT [R-AUDIO-L]
Connect RCA audio cables to AUDIO OUT [R-AUDIO-L] on the rear of your set and the other ends to corresponding 
audio in connectors on the Amplifier or DVD Home Theatre.

6	HDMI IN 1 (DVI), 2, 3
Supports connections between HDMI-connection-enabled AV devices (Set-Top Boxes, DVD / Blu-ray player)
No additional Audio connection is needed for an HDMI to HDMI connection.
The HDMI IN 1 (DVI) jack can be used to connect a PC.
What is HDMI?
‘High Definition Multimedia interface’ allows the transmission of high definition digital video data and multiple channels of 
digital audio.
The HDMI / DVI terminal supports DVI connection to an extended device with the appropriate cable (not supplied). 
The difference between HDMI and DVI is that the HDMI device is smaller in size, has the HDCP (High Bandwidth Digital 
Copy Protection) coding feature installed, and supports multi - channel digital audio.
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7	 COMMON INTERFACE Slot
When not inserting ‘CI CARD’ in some channels, ‘Scrambled Signal’ is displayed on the screen.
The pairing information containing a telephone number, CI CARD ID, Host ID and other information will be displayed in 
about 2~3 minutes. If an error message is displayed, please contact your service provider.
When the channel information configuration has finished, the message ‘Updating Completed’ is displayed, indicating that 
the channel list is now updated.
You must obtain a CI CARD from a local cable service provider. Remove the CI CARD by carefully pulling it out with your 
hands since dropping the CI CARD may cause damage to it.
Insert the CI-Card in the direction marked on it.
The place of the COMMON INTERFACE Slot may be different depending on its model. 
CAM is not supported in some countries and regions, check with your authorized dealer.

8	 AV IN [VIDEO] / [R-AUDIO-L]
Connect RCA cable to an appropriate external A/V device such as VCR, DVD or Camcorder.
Connect RCA audio cables to [R-AUDIO-L] on your set and the other ends to corresponding audio out connectors on the 
A/V device.

9	 KENSINGTON LOCK (depending on the model)
The Kensington Lock (optional) is a device used to physically fix the system when used in a public place. If you want to 
use a locking device, contact the dealer where you purchased the TV.
The location of the Kensington Lock may be different depending on its model. 

0	 COMPONENT IN 
Connect component video cables (optional) to component connector (PR, PB, Y) on the rear of your set and the other ends 
to corresponding component video out connectors on the DTV or DVD.
If you wish to connect both the Set-Top Box and DTV (or DVD), you should connect the Set-Top Box to the DTV (or DVD) 
and connect the DTV (or DVD) to component connector (PR, PB, Y) on your set.
The PR, PB and Y connectors on your component devices (DTV or DVD) are sometimes labelled Y, B-Y and R-Y or Y, Cb 
and Cr.
Connect RCA audio cables (optional) to [R-AUDIO-L] on the rear of your set and the other ends to corresponding audio 
out connectors on the DTV or DVD.

!	 EXT

Connector Input Output
Video Audio (L / R) RGB Video + Audio (L / R)

EXT O O O Only TV or DTV output is available.
Inputs or outputs for external devices, such as VCR, DVD, video game device or video disc players.

@	 SERVICE
Connector for software upgrades.
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Remote Control
You can use the remote control up to a distance of about 23 feet from the TV.
The performance of the remote control may be affected by bright light.
The product colour and shape may vary depending on the model.

1	 POWER : Television Standby 
button.

2	 NUMERIC BUTTONS :  Press to 
change the channel.

3	 E : Performs the same function 
as the ENTERE key of the 
directional keys. When switching 
channels with the numeric 
buttons, and you press the 
channel number and then the 
ENTERE key, the channel is 
immediately switched.

4	 Y : Press to increase or 
decrease the volume.

5	 SOURCE: Press to display 
and select the available video 
sources.

6	 CH LIST: Displays the Channel 
List on screen

7	 TOOLS: Use to quickly select 
frequently used functions.

8	 INFO: Press to display 
information on the TV screen.

9	 COLOURS BUTTONS: Use 
these buttons in the Channel list 
menus etc.

!	 TV: Selects the TV mode directly.
@	 PRE-CH: Enables you to return 

to the previous channel you were 
watching.

#	 MUTE M: Press to temporarily 
cut off the sound.

$	 P </P >: Press to change 
channels.

%	 MENU: Displays the main on-
screen menu

^	 FAV.CH: Press to switch to your 
favourites channels.

&	 RETURN: Returns to the 
previous menu

*	 UP▲ / DOWN▼ / LEFT◄ / 
RIGHT► / ENTERE: Use to 
select on-screen menu items and 
change menu values.

(	 EXIT: Press to exit the menu.
)	 SUBT.: Digital subtitle display
a	 GUIDE: Electronic Programme 

Guide (EPG) display

Teletext Functions
5	 0: Teletext mode selection 

(LIST / FLOF)
6	 8: Teletext store
7	 4: Teletext size selection
8	 5: Teletext reveal
9	 Fastext topic selection
0	 /: Alternately select 

Teletext, Double, or Mix.
!	 :: Exit from the teletext display
@	 1: Teletext sub page
$	 2: Teletext next page

3: Teletext previous page
%	 6: Teletext index
&	 9: Teletext hold
(	 7: Teletext cancel

 

Installing Batteries in the Remote Control
1.	 Lift the cover at the back of the remote control upward as shown in the figure.
2.	 Install two AAA size batteries. 

Make sure to match the ‘+’ and ‘–’ ends of the batteries with the diagram inside the 
compartment.

3.	 Replace the cover.
Remove the batteries and store them in a cool, dry place if you won’t be using the 
remote control for a long time. 

If the remote control doesn’t work, check the following:
Is the TV power on? 
Are the plus and minus ends of the batteries reversed?
Are the batteries drained?
Is there a power outage or is the power cord unplugged?
Is there a special fluorescent light or neon sign nearby?
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OPERATION

Viewing the menus
Before using the TV, follow the steps below to learn how to navigate the menu in order to select 
and adjust different functions.
1.	 Press the MENU button.

The main menu is displayed on the screen. Its left side has icons: Picture, Sound, 
Channel , Setup, Input, Support.

2.	 Press the ▲ or ▼ button to select one of the icons.
Press the ◄ or ► button to access the icon’s sub-menu.

3.	 Press the ▲ or ▼ button to move to items in the menu.
Press the ENTERE button to enter items in the menu.

4.	 Press the ▲/▼/◄/► button to change the selected items.
Press the RETURN button to return to the previous menu.

5.	 Press the EXIT button to exit from the menu.

Using the remote control buttons
Button Operations Button Operations

MENU Display the main on-screen menu.
▲/▼/◄/►/ 
ENTERE

Move the cursor and select an item.
Select the currently selected item.
Confirm the setting.

RETURN R Return to the previous menu.
EXIT e Exit the on-screen menu.

Example: Setting the TV’s Brightness in the Picture Menu

Adjusting the Brightness to 80
1.	 Press the MENU button to display the menu. 

2.	 Press the ENTERE button to select Picture. 

3.	 Press the ▲ or ▼ button to select Brightness.

 

4.	 Press the ENTERE button. 

5.	 Press the ◄ or ► button until the brightness becomes 80.
6.	 Press the ENTERE button.

Press the EXIT button to exit from the menu.

¦

N



N

Mode	 : Standard 	 ►
Backlight	 : 8 

Contrast	 : 95

Brightness	 : 45

Sharpness	 : 50

Colour	 : 50

Tint (G / R)	 : G50 / R50

Picture

Mode	 : Standard	 ►
Backlight	 : 8 

Contrast	 : 95

Brightness	 : 45

Sharpness	 : 50

Color	 : 50

Tint (G/R)	 : G50/R50

Picture

Backlight	 : 8		
Contrast	 : 95

Brightness	 : 45	 	 ►
Sharpness	 : 50

Color	 : 50

Tint (G/R)	 : G50/R50

Advanced Settings

Picture Options

Picture Reset

Picture

Mode	 : Standard

Backlight	 : 8 

Contrast	 : 95

Brightness	 : 45

Sharpness	 : 50

Color	 : 50

Tint (G/R)	 : G50/R50

Picture

Brightness			   45

U Move      L Adjust     E Enter     R Return

Brightness			   80

U Move      L Adjust     E Enter     R Return

BN68-01981D-X0.indb   6 2009-03-02   �� 5:46:20

Downloaded From TV-Manual.com Manuals

http://www.tv-manual.com


English - �

Plug & Play Feature
When the TV is initially powered on, basic settings proceed automatically and subsequently.
1.	 Press the POWER button on the remote control. control. The message You can set the 

menu language. is displayed.
2.	 Select the appropriate language by pressing the ▲ or ▼ button. Press the ENTERE 

button to confirm your choice.
3.	 Press the ◄ or ► button to select Store Demo or Home Use, then the ENTERE button. 

We recommend setting the TV to Home Use mode for the best picture in your home environment. 
Store Demo mode is only intended for use in retail environments. 
If the unit is accidentally set to Store Demo mode and you want to return to Home Use (Standard): Press the Volume 
button on the TV. When the volume OSD is displayed, press and hold the MENU button on the TV for 5 seconds.

4.	 Press the ENTERE button. Select the appropriate country by pressing the ▲ or ▼ button. Press the ENTERE button to 
confirm your choice.

5.	 Press the ▲ or ▼ button to select Air or Cable, then press the ENTERE button.
Air: Air antenna signal.
Cable: Cable antenna signal.

6.	 Press the ▲ or ▼ button to select the channel source to memorize. Press the ENTERE button to select Start.
Digital & Analogue: Digital and Analogue channels. 
Digital: Digital channels. 
Analogue: Analogue channels.
When setting the antenna source to Cable, a step appears allowing you to set a value for the digital channel search. For 
more information, refer to Channel → Auto Store. 
The channel search will start and end automatically.
Press the ENTERE button at any time to interrupt the memorization process.
After all the available channels are stored, the message Set the Clock Mode. is displayed.

7.	 Press the ENTERE button. Press the ▲ or ▼ button to select Auto, then Press the ENTERE button.
If you select Manual, Set current date and time is displayed.
If you have received a digital signal, the time will be set automatically. If not, select Manual to set the clock. (refer to page 
18)

8.	 The connection method to provide the best quality HD is offered. After confirming the method, press the ENTERE button.
9.	 The message Enjoy your viewing is displayed. When you have finished, press the ENTERE button.

If you want to reset this feature...
1.	 Press the MENU button to display the menu. Press the ▲ or ▼ button to select Setup, then press the ENTERE button.
2.	 Press the ENTERE button again to select Plug & Play. 
3.	 Enter your 4 digit PIN number. The default PIN number of a new TV set is ‘0-0-0-0’. (refer to page 19)

If you want to change PIN number, use the Change PIN function. 
The Plug & Play feature is only available in the TV mode. 

¦
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Plug & Play
You can set the menu language.

Menu Language	  : English 	 ►

E Enter
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CHANNEL CONTROL

Configuring the Channel Menu

Country
The PIN number input screen appears. Enter your 4 digit PIN number. 

Analogue Channel
You can change the country for analogue channels.
Digital Channel
You can change the country for digital channels.

Auto Store
You can scan for the frequency ranges available to you (and availability depends on your 
country). Automatically allocated programme numbers may not correspond to actual or desired 
programme numbers.

If a channel is locked using the Child Lock function, the PIN input window appears.
Air / Cable
Antenna source to memorize

Digital & Analogue: Digital and Analogue channels. 
Digital: Digital channels. 
Analogue: Analogue channels.

When selecting Cable → Digital & Analogue or Cable → Digital
Provide a value to scan for cable channels.

Search Mode → Full / Network / Quick
Quick

Network ID: Displays the network identification code.
Frequency: Displays the frequency for the channel. (Differs in each country)
Modulation: Displays available modulation values.
Symbol Rate: Displays available symbol rates.

–
–
–
–

Scans for all channels with active broadcast stations and stores them in the TV’s memory.
If you want to stop Auto Store, press the ENTERE button. The Stop Auto Store? message will be displayed. 
Select Yes by pressing the ◄ or ► button, then press the ENTERE button.

Manual Store
Scans for a channel manually and stores it in the TV’s memory.
If a channel is locked using the Child Lock function, the PIN input window appears.

Digital Channel
Manual store for digital channels.

Digital Channel is only available in DTV mode.
Channel: Set the Channel number using the ▲, ▼ or number (0~9) buttons.
Frequency: Set the frequency using the number buttons.
Bandwidth: Set the bandwidth using the ▲, ▼ or number (0~9) buttons.
When it has finished, channels are updated in the channel list.
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Country	  	 	 ►
Auto Store

Manual Store

Cable Search Option

Now & Next Guide

Full Guide

Default Guide	 : Full Guide

Channel
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Analogue Channel
Manual store for analogue channel.

Programme (Programme number to be assigned to a channel): Sets the programme number using the ▲, ▼ or number (0~9) 
buttons.
Colour System → Auto / PAL / SECAM / NTSC4.43: Sets the colour system value using the ▲ or ▼ button.
Sound System → BG / DK / I / L: Sets the sound system value using the ▲ or ▼ button.
Channel (When you know the number of the channel to be stored): Press the ▲ or ▼ button to select C (Air channel) or S 
(Cable channel). Press the ► button, then press the ▲, ▼ or number (0~9) buttons to select the required number.

You can also select the channel number directly by pressing the number (0~9) buttons.
If there is abnormal sound or no sound, reselect the sound standard required.

Search (When you do not know the channel numbers): Press the ▲ or ▼ button to start the search. The tuner scans the 
frequency range until the first channel or the channel that you selected is received on the screen.
Store (When you store the channel and associated programme number): Set to OK by pressing the ENTERE button.
Channel mode

P (Programme mode): When completing tuning, the broadcasting stations in your area have been assigned to position 
numbers from P00 to P99. You can select a channel by entering the position number in this mode.
C (Air channel mode): You can select a channel by entering the assigned number to each air broadcasting station in this 
mode.
S (Cable channel mode): You can select a channel by entering the assigned number for each cable channel in this mode.

Cable Search Option (depending on the country)
Using this function, you can manually add the channel range to be scanned by Full Search mode of the Auto Store function.

Frequency (Start ~ Stop): Displays the frequency for the channel.
Modulation: Displays available modulation values.
Symbol Rate: Displays available symbol rates.

Now & Next Guide / Full Guide
The EPG (Electronic Programme Guide) information is provided by the broadcasters. Programme entries may appear blank or out 
of date as a result of the information broadcast on a given channel. The display will dynamically update as soon as new information 
becomes available.

For detailed procedures on using Now & Next Guide and Full Guide, refer to the descriptions on page 10.
You can also display the guide menu simply by pressing the GUIDE button. (To configure the Default Guide, refer to the 
descriptions.)

Now & Next Guide
For the six channels indicated in the left-hand column, displays the Current programme and the Next programme information.
Full Guide
Displays the programme information as time ordered One hour segments. Two hours of programme information is displayed which 
may be scrolled forwards or backwards in time.

Default Guide → Now & Next Guide / Full Guide
You can decide whether to display either the Now & Next Guide or the Full Guide when the GUIDE button on the remote control 
is pressed. 

Channel List
For detailed procedures on using the Channel List,refer to the ‘Managing Channels’ instructions.

You can select these options by simply pressing the CH LIST button on the remote control.

Channel Mode
When press the P >/< button, Channels will be switched within the selected channel list.
Added Ch.
Channels will be switched within the memorized channel list.
Favourite Ch.
Channels will be switched within the favourite channel list.

Fine Tune
If the reception is clear, you do not have to fine tune the channel, as this is done automatically during the search and store 
operation. If the signal is weak or distorted, you may have to fine tune the channel manually.

Fine tuned channels that have been saved are marked with an asterisk “*” on the right-hand side of the channel number in the 
channel banner.
To reset the fine-tuning, select Reset by pressing the ▲ or ▼ button and then press the ENTERE button. 
Only Analogue TV channels can be fine tuned.
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Using the Now & Next Guide / Full Guide

To... Then...
Watch a programme in the EPG list Select a programme by pressing the ▲, ▼, ◄, ► button.
Exit the guide Press the blue button
If the next programme is selected, it is scheduled with the clock icon displayed. If the ENTERE button is pressed again, press 
the ◄, ► button to select Cancel Schedules, the scheduling is cancelled with the clock icon gone. 
View programme information Select a programme of your choice by pressing the ▲, ▼, ◄, ► button. 

Then press the INFO button when the programme of your choice is 
highlighted.
The programme title is on the upper part of the screen centre. 

Please click on INFO button for detailed information. Channel Number, Running Time, Status Bar, Parental Level, Video Quality 
Information (HD / SD), Sound Modes, Subtitle or Teletext, languages of Subtitle or Teletext and brief summary of the highlighted 
programme are included on the detailed information. “...” will be appeared if the summary is long.
Toggle between the Now & Next Guide and Full 
Guide

Press the red button repeatedly.

In Full Guide 
Scrolls backwards quickly (24 hours). 
Scrolls forwards quickly (24 hours).

Press the green button repeatedly.
Press the yellow button repeatedly.

Managing Channels 
Using this menu, you can Add / Delete or set Favourite channels and use the programme guide for digital broadcasts.
All Channels
Shows all currently available channels.
Added Channels
Shows all added channels.
Favourites
Shows all favourite channels.

To select the Favourites channels you have set up, press the FAV.CH button on the remote 
control.

Programmed
Shows all current reserved programmes.

Select a channel in the All Channels, Added Channels or Favourites screen by pressing the ▲ / ▼ buttons, and pressing 
the ENTERE button. Then you can watch the selected channel.
Using the Colour buttons with the Channel List

Red (Channel Type): Toggle between your TV, Radio, Data / Other and All.
Green (Zoom): Enlarges or shrinks a channel number.
Yellow (Select): Selects multiple channel lists. You can perform the add / delete, add to Favourites / delete from 
Favourites, or lock / unlock function for multiple channels at the same time. Select the required channels and press the 
yellow button to set all the selected channels at the same time. The c mark appears to the left of the selected channels.
TOOLS (Tools): Displays the Delete (or Add), Add to Favourite (or Delete from Favourite), Lock (or Unlock), Timer 
Viewing, Edit Channel Name, Sort, Edit Channel Number, Select All, Deselect All or Auto Store menu. (The Options 
menus may differ depending on the situation.)
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824                  UKTV Gold
825                  UKTV style

A  1             C --
A  2                  C --
A  3    ♥            C --
A  4                  C --
A  5                  C --
A  6                  C --
A  7                  C --

Added Channels

All        ■ Channel Type           ■ Zoom           ■ Select          T Tools

Now & Next Guide
DTV Cable 900 f tn                               2:10  Tue 1 Jun
Freshmen On Campus
2:00 - 2:30
No Detailed Information

Now Next

Mint Extra
Loaded
Fresh 40 with Dynamite MC
The Distillery
Smash Hits! Sunday

1       f tn
2       ITV Play
3       Kerrang!
4       Kiss
5       oneword
6       Smash Hits!▼

Street Hypn..

Kisstory
No Information

No Information

No Information

Freshmen O..

 Watch                Information         ■ Full Guide        ■ Exit

Full Guide
DTV Cable 900 f tn                               2:10  Tue 1 Jun
Freshmen On Campus
2:00 - 2:30
No Detailed Information

Today 16:00 - 17:00 17:00 - 18:00

Mint Extra
Loaded
Fresh 40 with Dynamite MC
The Distillery
Smash Hits! Sunday

1       f tn
2       ITV Play
3       Kerrang!
4       Kiss
5       oneword
6       Smash Hits!▼

Street Hypn..

Kisstory
No Information

No Information

No Information

Freshmen O..

 Watch               Information        ■ Now / Next       ■ +24 Hours       ■ Exit
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Channel Status Display Icons
A : An analogue channel.
c: A channel selected by pressing the yellow button.
*: A channel set as a Favourite.
(: A programme currently being broadcast.
\: A locked channel.
): A reserved programme

Channel List Option Menu (in All Channels / Added Channels / Favourites)
Press the TOOLS button to use the option menu.
Option menu items may differ depending on the channel status.

Add / Delete
You can delete or add a channel to display the channels you want.

All deleted channels will be shown on All Channels menu.
A gray-coloured channel indicates the channel has been deleted. 
The Add menu only appears for deleted channels.
You can also delete a channel from the Added Channels or Favourite menu in the same 
manner.

Add to Favourite / Delete from Favourite
You can set channels you watch frequently as favourites.

Press the TOOLS button to display the Tools menu. You can also set the add to (or delete 
from) Favourite by selecting Tools → Add to Favourite (or Delete from Favourite).
The ‘*’ symbol will be displayed and the channel will be set as a favourite.
All favourite channels will be shown on Favourite menu.

Timer Viewing
If you reserve a programme you want to watch, the channel is automatically switched to the reserved channel in the Channel List; 
even when you are watching another channel. To reserve a programme, set the current time first. (See page 18.)

Only memorized channels can be reserved.
You can set the channel, day, month, year, hour and minute directly by pressing the number buttons on the remote control.
Reserving a programme will be shown in the Programmed menu.
Digital Programme Guide and Viewing Reservation
When a digital channel is selected, and you press the ► button, the Programme Guide for the channel appears. You can 
reserve a programme according to the procedures described above.

Edit Channel Name (analogue channels only)
Channels can labelled so that their call letters appear whenever the channel is selected.

The names of digital broadcasting channels are automatically assigned and cannot be labelled.
Edit Channel Number (digital channels only)
You can also edit the channel number by pressing the number buttons on the remote control.
Sort (analogue channels only)
This operation allows you to change the programme numbers of the stored channels. This operation may be necessary after using 
the auto store.
Lock / Unlock
You can lock a channel so that the channel cannot be selected and viewed. This function is available only when the Child Lock is 
set to On. (see page 19)

The PIN number input screen appears. Enter your 4 digit PIN number. 
The default PIN number of a new TV set is “0-0-0-0”. You can change the PIN, by selecting Change PIN from the menu.
The ‘\’ symbol will be displayed and the channel will be locked.

Select All / Deselect All
Select All: You can select all the channels in the channel list.
Deselect All: You can deselect all the selected channels.
You can only select Deselect All when there is a selected channel.

Auto Store
For further details on setting up options, refer to page 8.
If a channel is locked using the Child Lock function, the PIN input window appears.
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824                  UKTV Gold
825                  UKTV style

A  1             C --
A  2                  C --
A  3    ♥            C --
A  4                  C --
A  5                  C --
A  6                  C --
A  7                  C --

Added Channels

All        ■ Channel Type           ■ Zoom           ■ Select          T Tools

Delete
Add to Favourite
Timer Viewing
Edit Channel Name
Sort
Lock

▼
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Channel List Option Menu (in Programmed )
You can view, modify or delete a reservation.

Press the TOOLS button to use the option menu.
Change Info
Select to change a viewing reservation.
Cancel Schedules
Select to cancel a viewing reservation.
Information
Select to view a viewing reservation. (You can also change the reservation information.)
Select All
Select all reserved programmes.

N
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PICTURE CONTROL

Configuring the Picture Menu

Mode
You can select the type of picture which best corresponds to your viewing requirements.

Press the TOOLS button to display the Tools menu. You can also set the picture mode by 
selecting Tools → Picture Mode.

Dynamic
Selects the picture for high-definition in a bright room.
Standard
Selects the picture for the optimum display in a normal environment.
Movie
Selects the picture for viewing movies in a dark room. 

Backlight / Contrast / Brightness / Sharpness / Colour / Tint(G/R)
Your television has several setting options that allow you to control the picture quality.

Backlight: Adjusts the brightness of LCD back light.
Contrast: Adjusts the contrast level of the picture.
Brightness: Adjusts the brightness level of the picture
Sharpness: Adjusts the edge definition of the picture.
Colour: Adjusts colour saturation of the picture.
Tint(G/R): Adjusts the colour tint of the picture.  
Select a picture mode to be adjusted first. The adjusted values are saved for each picture mode.
When you make changes to Backlight, Contrast, Brightness, Sharpness, Colour or Tint(G/R), the OSD will be adjusted 
accordingly.
In analogue TV, Ext., AV modes of the PAL system, you cannot use the Tint(G/R) Function.
In PC mode, you can only make changes to Backlight, Contrast and Brightness.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
The energy consumed during use can be significantly reduced if the brightness level of the picture is reduced, which will 
reduce the overall running cost.

Advanced Settings
Samsung’s new TVs allow you to make even more precise picture settings than previous 
models. See below to adjust detailed picture settings.

Advanced Settings is available in Standard or Movie mode.
In PC mode, you can only make changes to Gamma and White Balance from among the 
Advanced Settings items.

Black Tone → Off / Dark / Darker / Darkest
You can select the black level on the screen to adjust the screen depth.
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1 / 1 / 2009

13:59	 5	 TV1	  Quincy, M.E

18:59	 2	 TV3	  The Equalizer

20:59	 2	 TV3	  McMillan & Wife

Programmed

         All           ■ Zoom     ■ Select    T Tools    E Information

Change Info
Cancel Schedules
Information
Select All

Mode	 : Standard 	 ►
Backlight	 : 7 

Contrast	 : 95

Brightness	 : 45

Sharpness	 : 50

Colour	 : 50

Tint (G / R)	 : G50 / R50

Picture

Colour	 : 50
Tint (G / R)	 : G50 / R50

Advanced Settings		 	 ►
Picture Options

Picture Reset

Picture
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Dynamic Contrast → Off / Low / Medium / High
You can adjust the screen contrast so that the optimal contrast is provided.
Gamma
You can adjust the Primary Colour (Red, Green, Blue) Intensity.
Colour Space
Colour Space is a colour matrix composed of red, green and blue colours. Select your favourite Colour Space to experience the 
most natural colour.

Native: Native Colour Space offers deep and rich colour tone.
Auto: Auto Colour Space automatically adjusts to the most natural colour tone based on programme sources.

White Balance
You can adjust the colour temperature for more natural picture colours.

R-Offset / G-Offset / B-Offset / R-Gain / G-Gain / B-Gain: You can adjust the Colour ‘temperature’ in the light areas by 
changing the values of R, G, B. Recommended for advanced users only.
Reset: The previously adjusted white balance will be reset to the factory defaults.

Flesh Tone
You can emphasize the pink ‘flesh tone’ in the picture.

Changing the adjustment value will refresh the adjusted screen.
Edge Enhancement → Off / On
You can emphasize object boundaries in the picture.

Picture Options
In PC mode, you can only make changes to the Colour Tone and Size from among the items in Picture Options.

Colour Tone → Cool / Normal / Warm1 / Warm2
You can select the most comfortable colour tone to your eyes.

Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Warm1 or Warm2 is only activated when the picture mode is Movie.

Size
You can select the picture size which best corresponds to your viewing requirements. 

Press the TOOLS button to display the Tools menu. You can also set the size by selecting Tools → Picture Size.
Auto Wide: Automatically adjusts the picture size to the 16:9 aspect ratio.
16:9: Adjusts the picture size to 16:9 appropriate for DVDs or wide broadcasting.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnifies the 16:9 wide picture (in the vertical direction) to fit the screen size.
4:3: This is the default setting for a video movie or normal broadcasting.
Screen Fit: Use the function to see the full image without any cut-off when HDMI (720p / 1080i) or Component (1080i) signals 
are input.
Depending on the input source, the picture size options may vary.
The items available may differ depending on the selected mode.
In PC Mode, only 16:9 and 4:3 mode can be adjusted.
Settings can be adjusted and stored for each external device you have connected to an input of the TV.
Temporary image retention may occur when viewing a static image on the set for more than two hours.
Wide Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the 
picture up / down. Then press the ENTERE button.
Zoom: Press the ► button to Select Position, then press the ENTERE button. Press the ▲ or ▼ button to move the picture 
up and down. Then press the ENTERE button. Press the ► button to Select Size, then press the ENTERE button. Press 
the ▲ or ▼ button to magnify or reduce the picture size in the vertical direction. Then press the ENTERE button.
After selecting Screen Fit in HDMI (1080i) or Component (1080i) mode: Select Position by pressing the ◄ or ►button. Use 
the ▲, ▼, ◄ or ► button to move the picture.
Reset: Press the ◄ or ► button to select Reset, then press the ENTERE button. You can initialize the setting.
If you use the Screen Fit function with HDMI 720p input, 1 line will be cut at the top, bottom, left and right as in the Overscan 
function.
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Screen Mode → 16:9 / Wide Zoom / Zoom / 4:3
When setting the picture size to Auto Wide in a 16:9 wide TV, you can determine the picture size you want to see the 4:3 WSS 
(Wide Screen Service) image or nothing. Each individual European country requires different picture size so this function is 
intended for users to select it.

16:9: Sets the picture to 16:9 wide mode.
Wide Zoom: Magnify the size of the picture more than 4:3.
Zoom: Magnify the size of the picture vertically on screen.
4:3: Sets the picture to 4:3 normal mode.
This function is available in Auto Wide mode.
This function is not available in PC, Component or HDMI mode.

Digital NR → Off / Low / Medium / High / Auto
If the broadcast signal received by your TV is weak, you can activate the Digital Noise Reduction feature to help reduce any static 
and ghosting that may appear on the screen.

When the signal is weak, select one of the other options until the best picture is displayed.
HDMI Black Level → Normal / Low
You can directly select the black level on the screen to adjust the screen depth.

This function is active only when the external input connects to HDMI (RGB signals).
Film Mode → Off / Auto
The TV can be set to automatically sense and process film signals from all sources and adjust the picture for optimum quality.

Film Mode is supported in TV, AV, COMPONENT (480i / 1080i) and HDMI (480i / 1080i).

Picture Reset → Reset Picture Mode / Cancel
Resets all picture settings to the default values.

Select a picture mode to be reset. The reset is performed for each picture mode.
Reset Picture Mode: Current picture values return to default settings.

Using Your TV as a Computer (PC) Display

Setting Up Your PC Software (Based on Windows XP)
The Windows display-settings for a typical computer are shown below. The actual screens on your PC will probably be different, 
depending upon your particular version of Windows and your particular video card. However, even if your actual screens look 
different, the same basic set-up information will apply in almost all cases. (If not, contact your computer manufacturer or Samsung 
Dealer.)
1.	 First, click on ‘Control Panel’ on the Windows start menu.
2.	 When the control panel window appears, click on ‘Appearance and Themes’ and a display dialog-box will appear.
3.	 When the control panel window appears, click on ‘Display’ and a display dialogbox will appear.
4.	 Navigate to the ‘Settings’ tab on the display dialog-box.

The correct size setting (resolution): Optimum-1360 X 768 pixels
If a vertical-frequency option exists on your display settings dialog box, the correct value is ‘60’ or ‘60 Hz’. Otherwise, just click 
‘OK’ and exit the dialog box.
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Display Modes
Both screen position and size will vary depending on the type of PC monitor and its resolution. The resolutions in the table are 
recommended.

D-Sub and HDMI/DVI Input

Mode Resolution Horizontal Frequency 
(KHz)

Vertical Frequency 
(Hz)

Pixel Clock Frequency 
(MHz)

Sync Polarity 
(H / V)

IBM 640 x 350 31.469 70.086 25.175 +/-
720 x 400 31.469 70.087 28.322 -/+

MAC 640 x 480 35.000 66.667 30.240 -/-
832 x 624 49.726 74.551 57.284 -/-

VESA CVT 720 x 576 35.910 59.950 32.750 -/+
1280 x 720 44.772 59.855 74.500 -/+
1280 x 720 56.456 74.777 95.750 -/+

VESA DMT 640 x 480 31.469 59.940 25.175 -/-
640 x 480 37.500 75.000 31.500 -/-
640 x 480 37.861 72.809 31.500 -/-
800 x 600 37.879 60.317 40.000 +/+
800 x 600 46.875 75.000 49.500 +/+
800 x 600 48.077 72.188 50.000 +/+

1024 x 768 48.363 60.004 65.000 -/-
1024 x 768 56.476 70.069 75.000 -/-
1024 x 768 60.023 75.029 78.750 +/+
1360 x 768 47.712 60.015 85.500 +/+

VESA GTF 1280 x 720 52.500 70.000 89.040 -/+

When using an HDMI / DVI cable connection, you must use the HDMI IN 1 (DVI) jack.
The interlace mode is not supported.
The set might operate abnormally if a non-standard video format is selected.
Separate and Composite modes are supported. SOG is not supported.

Setting up the TV with your PC
Preset: Press the SOURCE button to select PC mode.

Auto Adjustment
Auto Adjustment allows the PC screen of set to self-adjust to the incoming PC video signal. The 
values of fine, coarse and position are adjusted automatically.

This function does not work in DVI-HDMI mode.
Press the TOOLS button to display the Tools menu. You can also set the Auto Adjustment 
by selecting Tools → Auto Adjustment.

Screen
Coarse / Fine
The purpose of picture quality adjustment is to remove or reduce picture noise. If the noise is not removed by Fine-tuning alone, 
then adjust the frequency as best as possible (Coarse) and Fine-tune again. After the noise has been reduced, readjust the picture 
so that it is aligned on the centre of screen.
PC Position
Adjust the PC’s screen positioning if it does not fit the TV screen. Press the ▲ or ▼ button to adjusting the Vertical-Position. Press 
the ◄ or ► button to adjust the Horizontal-Position.
Image Reset
You can replace all image settings with the factory default values.
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Brightness	 : 45 
Sharpness	 : 50

Auto Adjustment	 	 	 ►
Screen	

Advanced Settings	

Picture Options	  

Picture Reset	

Picture
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SOUND CONTROL

Configuring the Sound Menu

Mode → Standard / Music / Movie / Clear Voice / Custom
You can select a sound mode to suit your personal preferences.

Press the TOOLS button to display the Tools menu. You can also configure the sound 
mode by selecting Tools → Sound Mode.

Standard
Selects the normal sound mode.
Music
Emphasizes music over voices.
Movie
Provides the best sound for movies.
Clear Voice
Emphasizes voice over other sounds.
Custom
Recalls your customized sound settings.

Equalizer
The sound settings can be adjusted to suit your personal preferences.
Mode
You can select a sound mode to suit your personal preferences.
Balance
Controls the balance between the right and left speakers.
100Hz / 300Hz / 1KHz / 3KHz / 10KHz (Bandwidth Adjustment)
To adjust the level of different bandwidth frequencies
Reset
Resets the equalizer settings to the default values.

SRS TruSurround HD → Off / On
SRS TruSurround HD is a patented SRS technology that solves the problem of playing 5.1 multichannel content over two 
speakers. TruSurround delivers a compelling, virtual surround sound experience through any two-speaker playback system, 
including internal television speakers. It is fully compatible with all multichannel formats.

Press the TOOLS button to display the Tools menu. You can also set the SRS TruSurround HD by selecting Tools → SRS TS 
HD.

Audio Language (digital channels only)
You can change the default value for audio languages. Displays the language information for the incoming stream.

You can only select the language among the actual languages being broadcast.

Audio Format → MPEG / Dolby Digital (digital channels only)
When sound is emitted from both the main speaker and the audio receiver, a sound echo may occur due to the decoding speed 
difference between the main speaker and the audio receiver. In this case, use the TV Speaker function.

The Audio Format appears according to the broadcasting signal.
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Mode	 : Custom	 ►
Equalizer

SRS TruSurround HD	 : Off

Audio Language	 : - - -

Audio Format	 : - - -

Audio Description

Auto Volume	 : Off

Sound
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Audio Description (digital channels only)
This is an auxiliary audio function that provides an additional audio track for visually challenged persons. This function handles the 
Audio Stream for the AD (Audio Description), when it is sent along with the Main audio from the broadcaster. Users can turn the 
Audio Description On or Off and control the volume.
Audio Description → Off / On
Turn the audio description function on or off.
Volume
 You can adjust the audio description volume.

Volume is active when Audio Description is set to On.

Auto Volume → Off / On
Each broadcasting station has its own signal conditions, and so it is not easy to adjust the volume every time the channel is 
changed. This feature lets you automatically adjust the volume of the desired channel by lowering the sound output when the 
modulation signal is high or by raising the sound output when the modulation signal is low.

Speaker Select → External Speaker / TV Speaker
If you want to hear the sound through separate speakers, cancel the internal amplifier.

The volume and MUTE buttons do not operate when the Speaker Select is set to External Speaker.
If you select External Speaker in the Speaker Select menu, the sound settings will be limited.

Sound Reset → Reset All / Reset Sound Mode / Cancel
You can restore the Sound settings to the factory defaults.

Selecting the Sound Mode
You can set the sound mode in the Tools menu. When you set to Dual l ll, the current sound mode is displayed on the screen.

Audio Type Dual 1 / 2 Default

A2 Stereo
Mono MONO

Automatic change
Stereo STEREO ↔ MONO
Dual DUAL 1 ↔ DUAL 2 DUAL 1

NICAM 
Stereo

Mono MONO
Automatic change

Stereo MONO ↔ STEREO

Dual MONO ↔ DUAL 1 
DUAL 2 DUAL 1

If the stereo signal is weak and an automatic switching occurs, then switch to the mono.
This function is only activated in stereo sound signal. It is deactivated in mono sound signal.
This function is only available in TV mode.
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SETUP

Configuring the Setup Menu

Language
You can set the menu language.

Time
Clock
Setting the clock is necessary in order to use the various timer features of the TV.

The current time will appear every time you press the INFO button.
If you disconnect the power cord, you have to set the clock again.
Clock Mode
You can set up the current time manually or automatically.

Auto: Set the current time automatically using the time from the digital broadcast.
Manual: Set the current time to a manually specified time.
Depending on the broadcast station and signal, the auto time may not be set correctly. 
If this occurs, set the time manually. 
The Antenna or cable must be connected in order to set the time automatically.

Clock Set
You can set the current time manually.

Set up this item when you have set Clock Mode to Manual.
You can set the day, month, year, hour and minute directly by pressing the number 
buttons on the remote control.

Sleep Timer →  Off / 30 min / 60 min / 90 min / 120 min / 150 min / 180 min
The sleep timer automatically shuts off the TV after a preset time (30, 60, 90, 120, 150 and 180 minutes).

The TV automatically switches to standby mode when the timer reaches 0.
To cancel the Sleep Timer function, select Off.
Press the TOOLS button to display the Tools menu. You can also set the sleep timer by selecting Tools → Sleep Timer.

Timer 1 / Timer 2 / Timer 3
Three different on / off timer settings can be made. You must set the clock first.

On Time: Set the hour, minute, and activate / inactivate. (To activate the timer with the setting you’ve chosen, set to Activate.)
Off Time: Set the hour, minute, and activate / inactivate. (To activate the timer with the setting you’ve chosen, set to Activate.)
Volume: Select the desired turn on volume level.
Antenna: Select Air or Cable.
Channel: Select the desired channel.
Repeat: Select Once, Everyday, Mon~Fri, Mon~Sat, Sat~Sun, or Manual.

When Manual is selected, press the ► button to select the desired day of the week. Press the ENTERE button over the 
desired day and the c mark will appear.

You can set the hour, minute and channel by pressing the number buttons on the remote control.
Auto Power Off
When you set the timer On, the television will eventually turn off, if no controls are operated for 3 hours after the TV was 
turned on by the timer. This function is only available in timer On mode and prevents overheating, which may occur if a TV is 
on for too long time.

Game Mode → Off / On
When connecting to a game console such as PlayStation™ or Xbox™, you can enjoy a more realistic gaming experience by 
selecting the game menu.

To disconnect the game console and connect another external device, cancel game mode in the setup menu. If you display 
the TV menu in Game Mode, the screen shakes slightly.
Game Mode is not available in regular TV and PC mode.
If Game Mode is On:

Picture mode is automatically changed to Standard and users cannot change the mode.
Sound mode is automatically changed to Custom and users cannot change the mode. Adjust the sound using the 
equalizer.
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Plug & Play	

Language	 : English	 ►
Time

Game Mode	 : off

Child Lock	 : On	

Change PIN

Parental Lock

Subtitle

Setup

Subtitle
Teletext Language	 : - - -

Preference	 	 	 ►
Digital Text	 : Enable	

Melody	 : Medium

Game Mode	 : Off

Energy Saving 	 : Off

Common Interface

Setup
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Child Lock → Off / On
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by muting out video 
and audio.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is “0-0-0-0”. You can change the PIN by selecting Change PIN from the menu.
You can lock some channels in Channel List. (refer to page 11)
Child Lock is available only in TV mode.

Change PIN
You can change your personal ID number that is required to set up the TV.

Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is “0-0-0-0”.
If you forget the PIN code, press the remote control buttons in the following sequence, which resets the PIN to 0-0-0-0: 
POWER (Off), MUTE, 8, 2, 4, POWER (On).

Parental Lock
This feature allows you to prevent unauthorized users, such as children, from watching unsuitable programme by a 4-digit PIN 
(Personal Identification Number) code that is defined by the user.

The Parental Rating item differs depending on the country.
Before the setup screen appears, the PIN number input screen appears. Enter your 4 digit PIN number.
The default PIN number of a new TV set is “0-0-0-0”. You can change the PIN by selecting Change PIN from the menu.
When the parental ratings are set, the \ symbol is displayed.
Allow All: Press to unlock all TV ratings.
Block All: Press to lock all TV ratings.

Subtitle
You can activate and deactivate the subtitles. Use this menu to set the Subtitle Mode. Normal under the menu is the basic subtitle 
and Hard of hearing is the subtitle for a hearing-impaired person.

Subtitle → Off / On : Switches subtitles on or off.
Mode → Normal / Hard of hearing: Sets the subtitle mode.
Subtitle Language: Set the subtitle language.
If the programme you are watching does not support the Hard of hearing function, Normal automatically activates even 
though Hard of hearing mode is selected.
English is the default in cases where the selected language is unavailable in the broadcast.
You can select these options simply by pressing the SUBT. button on the remote control.

Teletext Language
You can set the Teletext language by selecting the language type.

English is the default in cases where the selected language is unavailable in the broadcast.

Preference
Primary Audio Language / Secondary Audio Language / Primary Subtitle Language / Secondary Subtitle Language / 
Primary Teletext Language / Secondary Teletext Language 
Using this feature, users can select one of the languages. The language selected here is the default when the user selects a 
channel.
If you change the language setting, the Subtitle Language, Audio Language, and the Teletext Language of the Language menu are 
automatically changed to the selected language.
The Subtitle Language, Audio Language, and the Teletext Language of the Language menu show a list of languages supported 
by the current channel and the selection is highlighted. If you change this language setting, the new selection is only valid for the 
current channel. The changed setting does not change the setting of the Primary Subtitle Language, Primary Audio Language, or 
the Primary Teletext Language of the Preference menu.

Digital Text → Disable / Enable
If the programme is broadcast with digital text, this feature is enabled.

MHEG (Multimedia and Hypermedia Information Coding Experts Group)
An International standard for data encoding systems used in multimedia and hypermedia. This is at a higher level than the 
MPEG system which includes data-linking hypermedia such as still images, character service, animation, graphic and video 
files as well as multimedia data. MHEG is user runtime interaction technology and is being applied to various fields including 
VOD (Video-On-Demand), ITV (Interactive TV), EC (Electronic Commerce), tele-education, tele-conferencing, digital libraries 
and network games.

❑

N
N
N
N

❑

N
N
N

❑

N
N
N
N
N

❑

●
●
●
N

N
O

❑

N

❑



❑

N

BN68-01981D-X0.indb   19 2009-03-02   �� 5:46:21

Downloaded From TV-Manual.com Manuals

http://www.tv-manual.com


English - 20

Melody → Off / Low / Medium / High
A melody sound can be set to come on when the TV is powered On or Off.

The Melody does not play 
When no sound is output from the TV because the MUTE button has been pressed.
When no sound is output from the TV because the (–) Volume button has been pressed.
When the TV is turned off by Sleep Timer function.

Energy Saving → Off / Low / Medium / High / Auto
This feature adjusts the brightness of the TV in order to reduce power consumption. When watching TV at night, set the Energy 
Saving mode option to High to reduce eye fatigue as well as power consumption.

Press the TOOLS button to display the Tools menu. You can also set the Energy Saving option by selecting Tools → Energy 
Saving.

Common Interface
CI Menu
This enables the user to select from the CAM-provided menu. Select the CI Menu based on the menu PC Card.
Application Info.
This contains information on CAM inserted in the CI slot and displays it. 

The Application Info inserting is about the CI CARD. You can install the CAM anytime whether the TV is ON or OFF.
1. 	 Purchase the CI CAM module by visiting your nearest dealer or by phone.
2.	 Insert the CI CARD into the CAM in the direction of the arrow until it fits.
3. 	 Insert the CAM with the CI CARD installed into the common interface slot. (Insert the CAM in the direction of the arrow, right 

up to the end so that it is parallel with the slot.)
4. 	 Check if you can see a picture on a scrambled signal channel.

CAM is not supported in some countries and regions, check with your authorized dealer.
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INPUT / SUPPORT

Configuring the Input Menu

Source List
Use to select TV or other external input sources such as DVD / Blu-ray players / Satellite 
receivers (Set-Top Box) connected to the TV. Use to select the input source of your choice.
TV / Ext. / AV / Component / PC / HDMI1/DVI / HDMI 2 / HDMI 3

You can choose only those external devices that are connected to the TV. In the Source 
List, connected inputs will be highlighted and sorted to the top. Inputs that are not 
connected will be sorted to the bottom.
TOOLS (Tools): Displays the Edit Name and Information menus.
Press the SOURCE button on the remote control to view an external signal source.  
TV mode can be selected by pressing the TV button.

Edit Name
Name the device connected to the input jacks to make your input source selection easier.
VCR / DVD / Cable STB / Satellite STB / PVR STB / AV Receiver / Game / Camcorder / PC / DVI PC / DVI / TV / IPTV /  
Blu- ray / HD DVD / DMA 
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Configuring the Support Menu

Self Diagnosis
Picture Test
If you think you have a picture problem, perform the picture test. Check the colour pattern on 
the screen to see if the problem still exists.

Yes: If the test pattern does not appear or there is noise in the test pattern, select Yes. 
There may be a problem with the TV. Contact Samsung’s call centre for assistance.
No: If the test pattern is properly displayed, select No. There may be a problem with your 
external equipment. Please check your connections. If the problem still persists, refer to 
the external device’s user manual.

Sound Test
If you think you have a sound problem, please perform the sound test. You can check the 
sound by playing a built-in melody sound through the TV. ‘Does the problem still exist with this 
sound test?’ appears on the screen.

If you hear no sound from the TV’s speakers, before performing the sound test, make sure Speaker Select is set to TV 
speaker in the Sound menu.
The melody will be heard during the test even if Speaker Select is set to External Speaker or the sound is muted by pressing 
the MUTE button.
Yes: If during the sound test you can hear sound only from one speaker or not at all, select Yes. There may be a problem with 
the TV. Contact Samsung’s call centre for assistance.
No: If you can hear sound from the speakers, select No. There may be a problem with your external equipment. Please check 
your connections. If the problem still persists, refer to the external device’s user manual. 

Signal Information (digital channels only)
Unlike analogue channels, which can vary in reception quality from ‘snowy’ to clear, digital (HDTV) channels have either perfect 
reception quality or you will not receive them at all. So, unlike analogue channels, you cannot fine tune a digital channel. You can, 
however, adjust your antenna to improve the reception of available digital channels.

If the signal strength meter indicates that the signal is weak, physically adjust your antenna to increase the signal strength. 
Continue to adjust the antenna until you find the best position with the strongest signal.

Software Upgrade
To keep your product up-to-date with new Digital Television features then software upgrades are 
periodically / broadcast as part of the normal Television signal. It will automatically detect these 
signals and display the software upgrade banner. You are given the option to install the upgrade.
BY USB
Insert a USB drive containing the firmware upgrade into TV. Please be careful to not disconnect 
the power or remove the USB drive while upgrades are being applied. The TV will turn off and 
turn on automatically after completing the firmware upgrade. Please check the firmware version 
after the update is completed. When software is upgraded, video and audio settings you have 
made will return to their default (factory) settings.
We recommend you write down your settings so that you can easily reset them after the upgrade.
BY Channel
Upgrades the software using the broadcasting signal.
Standby Mode Upgrade
To continue software upgrade with master power on, Select On by pressing the ▲ or ▼ button. 45 minutes after entering standby 
mode, a manual upgrade is automatically conducted. Since the power of the unit is turned on internally, the screen may be on 
slightly for the LCD product. This phenomenon may continue for more than 1 hour until the software upgrade is completed.
Alternative Software
To display the software version information.

HD Connection Guide
This menu presents the connection method that provides the optimal quality for the HD TV.
Refer to this information when connecting external devices to the TV.

Contact Samsung
View this information when your TV does not work properly or when you want to upgrade the software.
You can view the information regarding the call centre, product and software file download method.
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RECOMMENDATIONS FOR USE

Teletext Feature
Most television stations provide written information services via Teletext. The index page of the Teletext service gives you 
information on how to use the service. In addition, you can select various options to suit your requirements by using the remote 
control buttons.

For Teletext information to be displayed correctly, channel reception must be stable. Otherwise, information may be missing or 
some pages may not be displayed. 
You can change Teletext pages by pressing the numeric buttons on the remote control.

1	 0 (mode)
Press to select the Teletext mode 
(LIST/FLOF). If you press it in the 
LIST mode, it switches into the List 
save mode. In the List save mode, 
you can save Teletext page into list 
using the 8 (store) button.

2	 8 (store)
Used to store the Teletext pages.

3	 4 (size)
Press to display the double-size 
letters in the upper half of the screen. 
For lower half of the screen, press 
it again. To display normal screen, 
press it once again.

4	 5 (reveal)
Used to display the hidden text 
(answers to quiz games, for 
example). To display normal screen, 
press it again.

5	 Colour buttons (red/green/yellow/
blue)
If the FASTEXT system is used 
by a broadcasting company, the 
different topics covered on a 
Teletext page are colour-coded 
and can be selected by pressing 
the coloured buttons. Press one of 
them corresponding to the required. 
The page is displayed with other 
coloured information that can be 
selected in the same way. To display 
the previous or next page, press the 
corresponding coloured button.

6	 / (Teletext on/mix)
Press to activate Teletext mode after 
selecting the channel providing the 
Teletext service. Press it twice to 
overlap the Teletext with the current 
broadcasting screen.

7	 : (exit)
Exit from the Teletext display.

8	 1 (sub-page)
Used to display the available sub-
page.

9	 2 (page up)
Used to display the next Teletext page.

0	 3 (page down)
Used to display the previous Teletext 
page.

!	 9 (hold)
Used to hold the display on a given 
page if the selected page is linked with 
several secondary pages which follow 
on automatically. To resume, press it 
again.

@	 6 (index)
Used to display the index (contents) 
page at any time while you are viewing 
Teletext.

#	 7 (cancel)
Used to display the broadcast when 
searching for a page.

 

The Teletext pages are organized according to six categories:

Part Contents
A Selected page number.
B Broadcasting channel identity.
C Current page number or search indications.
D Date and time.
E Text.
F Status information.

FASTEXT information.
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Teletext information is often divided between several pages displayed in sequence, which can be accessed by:
Entering the page number
Selecting a title in a list
Selecting a coloured heading (FASTEXT system)

Teletext level supported by the TV is version 2.5 which is capable of displaying additional graphics or text.
Depending upon the transmission, blank side panels can occur when displaying Teletext.
In these cases, additional graphics or text is not transmitted.
Older TV’s which do not support version 2.5 are not capable of displaying any additional graphics or text, regardless of the 
Teletext transmission.
Press the TV button to exit from the Teletext display.
Teletext 16:9, picture is 16:9.

Installing the Stand

Preset: Place the Guide Stand and Cover Neck onto the stand and fasten it using the 
screws. Applicable to 32 inch model only.

N

1.	 Attach your LCD TV to the stand.
Two or more people should carry the TV.
Make sure to distinguish between the front and back of the stand when assembling 
them.
To make sure the TV is installed on the stand at a proper level, do not apply excess 
downward pressure to the upper left of right sides of the TV.

2.	 Fasten two screws at position 1 and then fasten two screw at position 2.
Stand the product up and fasten the screws. If you fasten the screws with the LCD TV 
placed down, it may lean to one side.
The stand is installed for models with the screen size of 37 inch and above.

N
N

N

N

N

Installing the Wall Mount Kit

Wall mount items (sold separately) allow you to mount the TV on the wall.
For detailed information on installing the wall mount, see the instructions provided with the 
Wall Mount items. Contact a technician for assistance when installing the wall mounted 
bracket.
Samsung Electronics is not responsible for any damage to the product or injury to yourself or 
others if you elect to install the TV on your own.

Do not install your Wall Mount Kit while your TV is turned on. It may result in personal 
injury due to electric shock.

Remove the stand and cover the bottom hole with a cap and fasten with two screws.N

Using the Anti-Theft Kensington Lock

The Kensington Lock is a device used to physically fix the system when using it in a public 
place. The appearance and locking method may differ from the illustration depending on the 
manufacturer. Refer to the manual provided with the Kensington Lock for proper use. The 
locking device has to be purchased separately. The location of the Kensington Lock may be 
different depending on its model.
1.	 Insert the locking device into the Kensington slot on the LCD TV (1) and turn it in the 

locking direction (2).
2.	 Connect the Kensington Lock cable (3).
3.	 Fix the Kensington Lock to a desk or a heavy stationary object.
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Securing the TV to the Wall

Caution: Pulling, pushing, or climbing on the TV may cause the TV to fall. In particular, ensure your children do 
not hang over or destabilize the TV; doing so may cause the TV to tip over, causing serious injuries or death. 
Follow all safety precautions provided on the included Safety Flyer. For added stability, install the anti-fall device 
for safety purposes, as follows.

To avoid the TV from falling:
1.	 Put the screws into the clamps and firmly fasten them onto the wall. Confirm that the 

screws have been firmly installed onto the wall.
You may need additional material such as an anchor depending on the type of wall.
Since the necessary clamps, screws, and string are not supplied, please purchase 
these additionally.

2.	 Remove the screws from the centre back of the TV, put the screws into the clamps, and 
then fasten the screws onto the TV again.

Screws may not be supplied with the product. In this case, please purchase the 
screws of the following specifications. 
Screw Specifications
For a 17 ~ 29 Inch LCD TV: M4 X 15 / For a 32 ~ 40 Inch LCD TV: M6 X 15

3.	 Connect the clamps fixed onto the TV and the clamps fixed onto the wall with a strong 
string and then tie the string tightly.

Install the TV near to the wall so that it does not fall backwards.
It is safe to connect the string so that the clamps fixed on the wall are equal to or 
lower than the clamps fixed on the TV.
Untie the string before moving the TV.

4.	 Verify all connections are properly secured. Periodically check connections for any 
sign of fatigue for failure. If you have any doubt about the security of your connections, 
contact a professional installer.
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Troubleshooting: Before Contacting Service Personnel

No sound or picture Check that the mains lead has been connected to a wall socket.
Check that you have pressed the button on your set.
Check the picture contrast and brightness settings.
Check the volume.

●
●
●
●

Normal picture but no sound Check the volume.
Check whether the MUTEM button has been pressed on the remote control.
Check the Speaker Select settings.

●
●
●

Screen is black and power indicator 
light blinks steadily

On your computer check; Power, Signal Cable.
The TV is using its power management system.
Move the computer’s mouse or press any key on the keyboard.

●
●
●

No picture or black and white picture Adjust the colour settings.
Check that the broadcast system selected is correct.

●
●

Sound and picture interference Try to identify the electrical appliance that is affecting the set and move it further away.
Plug your set into a different mains socket.

●
●

Blurred or snowy picture, distorted 
sound

Check the direction, location and connections of your aerial.
This interference is often due to the use of an indoor aerial.

●
●

Remote control malfunctions Replace the remote control batteries.
Clean the upper edge of the remote control (transmission window).
Check the battery terminals.

●
●
●

‘Check signal cable.’ message is 
displayed

Check that the signal cable is firmly connected to the PC or video sources.
Check that the PC or video sources are turned on.

●
●

On PC mode, ‘Not Supported Mode.’ 
message is displayed

Check the maximum resolution and the frequency of the video adaptor.
Compare these values with the data in the Display Modes.

●
●

The damaged picture appears in the 
corner of the screen

If Screen Fit is selected in some external devices, the damaged picture may appear in 
the corner of the screen. This symptom is caused by external devices, not TV.

The ‘Resets all settings to the default 
values.’ message appears.

This appears when you press and hold the EXIT button for a while. The product settings 
are reset to the factory defaults.

You may see small particles if you 
look closely at the edge of the bezel 
surrounding the TV screen.

This is part of the product’s design and is not a defect.

The TFT LCD panel uses a panel consisting of sub pixels (3 133 440) which require sophisticated technology to produce. 
However, there may be few bright or dark pixels on the screen. These pixels will have no impact on the performance of the 
product.

Specifications

Model Name LE26B450 LE32B450
Screen Size 
(Diagonal) 26 inches 32 inches
Power Consumption
Standby <1W <1W
PC Resolution
(Optimum) 1360 x 768 @ 60Hz 1360 x 768 @ 60Hz
Sound
(Output) 10W X 2 10W X 2
Dimensions (WxDxH)
Body
With stand

670 x 75 x 455 mm
670 x 216 x 495 mm

800 x 85 x 531 mm
800 x 252 x 577 mm

Weight
With Stand 8 kg 12 kg
Environmental Considerations
Operating Temperature
Operating Humidity
Storage Temperature
Storage Humidity

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

10°C to 40°C (50°F to 104°F)
10% to 80%, non-condensing
-20°C to 45°C (-4°F to 113°F)
5% to 95%, non-condensing

Stand Swivel
Left / Right 0˚ -20˚ ~ 20˚

Design and specifications are subject to change without prior notice.
This device is a Class B digital apparatus.
For the power supply and Power Consumption, refer to the label attached to the product.
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Warning! Important Safety Instructions

Please read the appropriate section that corresponds to the marking on your Samsung product before attempting to install the product.

CAUTION
RISK OF ELECTRIC SHOCK DO NOT OPEN

CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK,  
DO NOT REMOVE COVER (OR BACK). THERE ARE  

NO USER SERVICEABLE PARTS INSIDE. REFER ALL  
SERVICING TO QUALIFIED PERSONNEL.

This symbol indicates that high voltage is present 
inside. It is dangerous to make any kind of contact 
with any internal part of this product.

This symbol alerts you that important literature  
concerning operation and maintenance has been 
included with this product.

The slots and openings in the cabinet and in the back or bottom are provided for necessary ventilation.  
To ensure reliable operation of this apparatus, and to protect it from overheating, these slots and openings must never be blocked or 
covered.

Do not cover the slots and openings with a cloth or other materials.
Do not block the slots and openings by placing this apparatus on a bed, sofa, rug or other similar surface.
Do not place this apparatus in a confined space, such as a bookcase, or built-in cabinet, unless proper ventilation is provided.
Give your product 10 cm (4 inch) clearance from the wall.

Do not place this apparatus near or over a radiator or heat resistor, or where it is exposed to direct sunlight.
Do not place heat generating items such as candles, ashtrays, incense, flammable gas or explosive materials near the product.
Do not place a water containing vessel on this apparatus, as this can result in a risk of fire  or electric shock.
Do not expose this apparatus to rain or place it near water(near a bathtub, washbowl, kitchen sink, or laundry tub, in a wet 
basement, or near a swimming pool etc.). If this apparatus accidentally gets wet, unplug it and contact an authorized dealer 
immediately. Make sure to pull out the power cord from the outlet before cleaning.
This apparatus use batteries. In your community there might be regulations that require you to dispose of these batteries  properly 
under environmental considerations. Please contact your local authorities for disposal or recycling information.
Do not overload wall outlets, extension cords or adaptors beyond their capacity, since this can result in fire or electric shock.
Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them, 
paying particular attention to cords at plug end, adaptors and the point where they exit from the appliance.
To protect this apparatus from a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the 
wall outlet and disconnect the antenna or cable system.  
This will prevent damage to the set due to lightning and power line surges.
Before connecting the AC power cord to the DC adaptor outlet, make sure the voltage designation of the DC adaptor corresponds to 
the local electrical supply.
Never insert anything metallic into the open parts of this apparatus. Doing so many create a danger of electric shock.
To avoid electric shock, never touch the inside of this apparatus. Only a qualified technician should open this apparatus.
Make sure to plug the power cord in until it is firmly inserted. When removing the power cord, make sure to hold the power plug 
when pulling the plug from the outlet. Do not touch the power cord with wet hands.
If this apparatus does not operate normally - in particular, if there are any unusual sounds or smells coming from it

unplug it immediately and contact an authorized dealer or service center.
Be sure to pull the power plug out of the outlet if the TV is to remain unused or if you are to leave the house for an extended period 
of time (especially when children, elderly or disabled people will be left alone in the house).  

Accumulated dust can cause an electric shock, an electric leakage or a fire by causing the power cord to generate sparks and heat 
or the insulation to deteriorate.

Be sure to contact an authorized service center, when installing your set in a location with heavy dust, high or low temperatures,high 
humidity, chemical substances and where it operates for 24 hours such as the airport, the train station etc. Failure to do so may 
cause serious damage to your set.
Use only a properly grounded plug and receptacle. 

An improper ground may cause electric shock or equipment damage. (Class l Equipment only.)
To disconnect the apparatus from the mains, the plug must be pulled out from the mains socket, therefore the mains plug shall be 
readily operable.
Do not allow children to hang onto the product.
Store the accessories (battery, etc.) in a location safely out of the reach of children.
Do not install the product in an unstable location such as a shaky self, a slanted floor or a location exposed to vibration.
Do not drop or impart any shock to the product. If the product is damaged, disconnect the power cord and contact a service center.

  �WARNING - TO PREVENT THE SPREAD OF FIRE,  
KEEP CANDLES OR OTHER OPEN FLAMES  
AWAY FROM THIS PRODUCT AT ALL TIMES.
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Wiring the Mains Power Supply Plug (UK Only)

IMPORTANT NOTICE 
The mains lead on this equipment is supplied with a moulded plug incorporating a fuse. The value of the fuse is indicated on the pin 
face of the plug and, if it requires replacing, a fuse approved to BSI1362 of the same rating must be used.
Never use the plug with the fuse cover omitted if the cover is detachable. If a replacement fuse cover is required, it must be of the same 
colour as the pin face of the plug. Replacement covers are available from your dealer.
If the fitted plug is not suitable for the power points in your house or the cable is not long enough to reach a power point, you should 
obtain a suitabl y approved extension lead or consult your dealer for assistance. However, if there is no alternative but to cut off the 
plug, remove the fuse and then safely dispose of the plug.
Do NOT connect the plug to a mains socket as there is a risk of shock hazard from the bared flexible cord.

IMPORTANT 
The wires in the mains lead are coloured in accordance with the following code: 
BLUE - NEUTRAL BROWN - LIVE 
As these colours may not correspond to the coloured markings identifying the terminals in your plug, proceed as follows : 
The wire coloured BLUE must be connected to the terminal marked with the letter N or coloured BLUE or BLACK. The wire coloured 
BROWN must be connected to the terminal marked with the letter L or coloured BROWN or RED.

WARNING: 
DO NOT CONNECT EITHER WIRE TO THE EARTH TERMINAL, WHICH IS MARKED WITH THE 
LETTER E OR BY THE EARTH SYMBOL , OR COLOURED GREEN OR GREEN AND YELLOW.

Warranty Card

United Kingdom

This Samsung product is warranted for a period of twelve (12) months from the original date of purchase, against defective materials 
and workmanship. In the event that warranty service is required, you should return the product to the retailer from whom it was 
purchased. However, Samsung Authorised Dealers and Authorised Service Centres in other EC Countries will comply with the warranty 
on the terms issued to purchasers in the country concerned. In case of difficulty, details of our Authorised Service Centres are available 
from:

Samsung Electronics U.K. Ltd.
Customer Care Centre

PO Box 17243
Edinburgh, EH11 4YB

United Kingdom
Tel: 0845 SAMSUNG (7267864) (UK & Northern Ireland)

Tel: 0818 717 100 (EIRE Only)
Fax: +44 0845 650 8080

Web : www.samsung.com

WARRANTY CONDITIONS
1.	 The warranty is only valid if, when warranty service is required, the warranty card is fully and properly completed and is presented 

with the original invoice or sales slip or confirmation, and the serial number on the product has not been defaced.
2.	 Samsung’s obligations are limited to the repair or, at its discretion, replacement of the product or the defective part.
3.	 Warranty repairs must be carried out by Authorised Samsung Dealers or Authorised Service Centres. No re-imbursement will be 

made for repairs carried out by non Samsung Dealers and, any such repair work and damage to the products caused by such 
repair work will not be covered by this warranty.

4.	 This product is not considered to be defective in materials nor workmanship by reason that it requires adaptation in order to 
conform to national or local technical or safety standards in force in any Country other than the one for which the product was 
originally designed and manufactured.
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Correct Disposal of This Product (Waste Electrical & Electronic Equipment) 
(Applicable in the European Union and other European countries with separate collection systems)
This marking shown on the product or its literature, indicates that it should not be disposed with other household wastes at the end of its working life. To prevent 
possible harm to the environment or human health from uncontrolled waste disposal, please separate this from other types of wastes and recycle it responsibly 
to promote the sustainable reuse of material resources. Household users should contact either the retailer where they purchased this  product, or their local 
government office, for details of where and how they can take this item for environmentally safe recycling. Business users should contact their supplier and check 
the terms and conditions of the purchase contract. This product should not be mixed with other commercial wastes for disposal.

[English]

The rechargeable battery incorporated in this product is not user replaceable. For information on its replacement, please contact your service provider.
[English]
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Correct Disposal of This Product (Waste Electrical & Electronic Equipment) 
(Applicable in the European Union and other European countries with separate collection systems) This marking on the product, accessories 
or literature indicates that the product and its electronic accessories (e.g. charger, headset, USB cable) should not be disposed of with other 
household waste at the end of their working life. To prevent possible harm to the environment or human health from uncontrolled waste 
disposal, please separate these items from other types of waste and recycle them responsibly to promote the sustainable reuse of material 
resources. Household users should contact either the retailer where they purchased this product, or their local government office, for details 
of where and how they can take these items for environmentally safe recycling. Business users should contact their supplier and check the 
terms and conditions of the purchase contract. This product and its electronic accessories should not be mixed with other commercial wastes 
for disposal.

[English]
Les bons gestes de mise au rebut de ce produit (Déchets d’équipements électriques et électroniques) 
(Applicable dans les pays de l’Union Européenne et dans d’autres pays européens pratiquant le tri sélectif)
Ce symbole sur le produit, ses accessoires ou sa documentation indique que ni le produit, ni ses accessoires électroniques usagés 
(chargeur, casque audio, câble USB, etc.) ne peuvent être jetés avec les autres déchets ménagers. La mise au rebut incontrôlée des 
déchets présentant des risques environnementaux et de santé publique, veuillez séparer vos produits et accessoires usagés des autres 
déchets. Vous favoriserez ainsi le recyclage de la matière qui les compose dans le cadre d’un développement durable. Les particuliers sont 
invités à contacter le magasin leur ayant vendu le produit ou à se renseigner auprès des autorités locales pour connaître les procédures et 
les points de collecte de ces produits en vue de leur recyclage. Les entreprises et professionnels sont invités à contacter leurs fournisseurs 
et à consulter les conditions de leur contrat de vente. Ce produit et ses accessoires ne peuvent être jetés avec les autres déchets 
professionnels et commerciaux.

[Français]
Korrekte Entsorgung von Altgeräten (Elektroschrott) 
(In den Ländern der Europäischen Union und anderen europäischen Ländern mit einem separaten Sammelsystem)
Die Kennzeichnung auf dem Produkt, Zubehörteilen bzw. auf der dazugehörigen Dokumentation gibt an, dass das Produkt und Zubehörteile 
(z. B. Ladegerät, Kopfhörer, USB-Kabel) nach ihrer Lebensdauer nicht zusammen mit dem normalen Haushaltsmüll entsorgt werden dürfen.
Entsorgen Sie dieses Gerät und Zubehörteile bitte getrennt von anderen Abfällen, um der Umwelt bzw. der menschlichen Gesundheit 
nicht durch unkontrollierte Müllbeseitigung zu schaden. Helfen Sie mit, das Altgerät und Zubehörteile fachgerecht zu entsorgen, um die 
nachhaltige Wiederverwertung von stofflichen Ressourcen zu fördern. Private Nutzer wenden sich an den Händler, bei dem das Produkt 
gekauft wurde, oder kontaktieren die zuständigen Behörden, um in Erfahrung zu bringen, wo Sie das Altgerät bzw. Zubehörteile für eine 
umweltfreundliche Entsorgung abgeben können. Gewerbliche Nutzer wenden sich an ihren Lieferanten und gehen nach den Bedingungen 
des Verkaufsvertrags vor. Dieses Produkt und elektronische Zubehörteile dürfen nicht zusammen mit anderem Gewerbemüll entsorgt 
werden.

[Deutsch]
Correcte verwijdering van dit product (elektrische & elektronische afvalapparatuur)
Dit merkteken op het product, de accessoires of het informatiemateriaal duidt erop dat het product en zijn elektronische accessoires (bv. 
lader, headset, USB-kabel) niet met ander huishoudelijk afval verwijderd mogen worden aan het einde van hun gebruiksduur. Om mogelijke 
schade aan het milieu of de menselijke gezondheid door ongecontroleerde afvalverwijdering te voorkomen, moet u deze artikelen van 
andere soorten afval scheiden en op een verantwoorde manier recyclen, zodat het duurzame hergebruik van materiaalbronnen wordt 
bevorderd. Huishoudelijke gebruikers moeten contact opnemen met de winkel waar ze dit product hebben gekocht of met de gemeente 
waar ze wonen om te vernemen waar en hoe ze deze artikelen milieuvriendelijk kunnen laten recyclen. Zakelijke gebruikers moeten 
contact opnemen met hun leverancier en de algemene voorwaarden van de koopovereenkomst nalezen. Dit product en zijn elektronische 
accessoires mogen niet met ander bedrijfsafval voor verwijdering worden gemengd.

[Nederlands]
Corretto smaltimento del prodotto (rifiuti elettrici ed elettronici)
(Applicabile nell’Unione Europea e in altri paesi europei con sistema di raccolta differenziata)  
Il marchio riportato sul prodotto, sugli accessori o sulla documentazione indica che il prodotto e i relativi accessori elettronici (quali 
caricabatterie, cuffia e cavo USB) non devono essere smaltiti con altri rifiuti domestici al termine del ciclo di vita. Per evitare eventuali danni 
all’ambiente o alla salute causati dall’inopportuno smaltimento dei rifiuti, si invita l’utente a separare il prodotto e i suddetti accessori da altri 
tipi di rifiuti e di riciclarli in maniera responsabile per favorire il riutilizzo sostenibile delle risorse materiali. Gli utenti domestici sono invitati a 
contattare il rivenditore presso il quale è stato acquistato il prodotto o l’ufficio locale preposto per tutte le informazioni relative alla raccolta 
differenziata e al riciclaggio per questo tipo di materiali. Gli utenti aziendali sono invitati a contattare il proprio fornitore e verificare i termini 
e le condizioni del contratto di acquisto. Questo prodotto e i relativi accessori elettronici non devono essere smaltiti unitamente ad altri rifiuti 
commerciali.

[Italiano]
Eliminación correcta de este producto (Residuos de aparatos eléctricos y electrónicos)
(Aplicable en la Unión Europea y en países europeos con sistemas de recogida selectiva de residuos)  
La presencia de este símbolo en el producto, accesorios o material informativo que lo acompañan, indica que al finalizar su vida útil ni el 
producto ni sus accesorios electrónicos (como el cargador, cascos, cable USB) deberán eliminarse junto con otros residuos domésticos. 
Para evitar los posibles daños al medio ambiente o a la salud humana que representa la eliminación incontrolada de residuos, separe 
estos productos de otros tipos de residuos y recíclelos correctamente. De esta forma se promueve la reutilización sostenible de recursos 
materiales. Los usuarios particulares pueden contactar con el establecimiento donde adquirieron el producto o con las autoridades locales 
pertinentes para informarse sobre cómo y dónde pueden llevarlo para que sea sometido a un reciclaje ecológico y seguro. Los usuarios 
comerciales pueden contactar con su proveedor y consultar las condiciones del contrato de compra. Este producto y sus accesorios 
electrónicos no deben eliminarse junto a otros residuos comerciales.

[Español]
Eliminação Correcta Deste Produto (Resíduos de Equipamentos Eléctricos e Electrónicos)
Esta marca apresentada no produto, nos acessórios ou na literatura – indica que o produto e os seus acessórios electrónicos (por exemplo, 
o carregador, o auricular, o cabo USB) não deverão ser eliminados juntamente com os resíduos domésticos no final do seu período de 
vida útil. Para impedir danos ao ambiente ou à saúde humana causados pela eliminação incontrolada de resíduos, deverá separar estes 
equipamentos de outros tipos de resíduos e reciclá-los de forma responsável, para promover uma reutilização sustentável dos recursos 
materiais. Os utilizadores domésticos deverão contactar o estabelecimento onde adquiriram este produto ou as entidades oficiais locais 
para obterem informações sobre onde e de que forma podem entregar estes equipamentos para permitir efectuar uma reciclagem segura 
em termos ambientais. Os utilizadores profissionais deverão contactar o seu fornecedor e consultar os termos e condições do contrato de 
compra. Este produto e os seus acessórios electrónicos não deverão ser misturados com outros resíduos comerciais para eliminação.

[Português]
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Korrekt avfallshantering av produkten (elektriska och elektroniska produkter)
Denna markering på produkten, tillbehören och i manualen anger att produkten och de elektroniska tillbehören (t.ex. laddare, headset, 
USB-kabel) inte bör sorteras tillsammans med annat hushållsavfall när de kasseras. Till förebyggande av skada på miljö och hälsa bör 
dessa föremål hanteras separat för ändamålsenlig återvinning av beståndsdelarna. Hushållsanvändare bör kontakta den återförsäljare 
som sålt produkten eller sin kommun för vidare information om var och hur produkten och tillbehören kan återvinnas på ett miljösäkert sätt. 
Företagsanvändare bör kontakta leverantören samt verifiera angivna villkor i köpekontraktet. Produkten och de elektroniska tillbehören bör 
inte hanteras tillsammans med annat kommersiellt avfall.

[Svenska]

Korrekt affaldsbortskaffelse af dette produkt (elektrisk & elektronisk udstyr)
Mærket på dette produkt, på tilbehør eller i den medfølgende dokumentation betyder, at produktet og elektronisk tilbehør hertil (f.eks. 
oplader, hovedsæt, USB-ledning) ikke må bortskaffes sammen med almindeligt husholdningsaffald efter endt levetid. For at undgå skadelige 
miljø- eller sundhedspåvirkninger på grund af ukontrolleret affaldsbortskaffelse skal ovennævnte bortskaffes særskilt fra andet affald og 
indleveres behørigt til fremme for bæredygtig materialegenvinding. Forbrugere bedes kontakte forhandleren, hvor de har købt produktet, 
eller kommunen for oplysning om, hvor og hvordan de kan indlevere ovennævnte med henblik på miljøforsvarlig genvinding. Virksomheder 
bedes kontakte leverandøren og læse betingelserne og vilkårene i købekontrakten. Dette produkt og elektronisk tilbehør hertil bør ikke 
bortskaffes sammen med andet erhvervsaffald.

[Dansk]

Korrekt avhending av dette produktet (Avfall fra elektrisk og elektronisk utstyr)
Denne merkingen som vises på produktet, dets tilbehør eller dokumentasjon, indikerer at produktet eller det elektroniske tilbehøret (for 
eksempel lader, headset, USB-kabel) ikke skal kastes sammen med annet husholdningsavfall ved slutten av levetiden. For å hindre 
potensiell skade på miljøet eller helseskader grunnet ukontrollert avfallsavhending ber vi om at dette avfallet holdes adskilt fra andre 
typer avfall og resirkuleres på ansvarlig måte for å fremme bærekraftig gjenbruk av materielle ressurser. Private forbrukere bør kontakte 
enten forhandleren de kjøpte produktet av, eller lokale myndigheter, for detaljer om hvor og hvordan disse artiklene kan resirkuleres på 
en miljøvennlig måte. Forretningsbrukere bør kontakte sin leverandør og undersøke vilkårene i kjøpskontrakten. Dette produktet og det 
elektroniske tilbehøret skal ikke blandes med annet kommersielt avfall som skal kastes.

[Norsk]

Tuotteen turvallinen hävittäminen (elektroniikka ja sähkölaitteet)
Oheinen merkintä tuotteessa, lisävarusteissa tai käyttöohjeessa merkitsee, että tuotetta tai lisävarusteina toimitettavia sähkölaitteita (esim. 
laturia, kuulokkeita tai USB kaapelia) ei saa hävittää kotitalousjätteen mukana niiden käyttöiän päätyttyä. Virheellisestä jätteenkäsittelystä 
ympäristölle ja terveydelle aiheutuvien haittojen välttämiseksi tuote ja lisävarusteet on eroteltava muusta jätteestä ja kierrätettävä 
kestävän kehityksen mukaista uusiokäyttöä varten. Kotikäyttäjät saavat lisätietoja tuotteen ja lisävarusteiden turvallisesta kierrätyksestä 
ottamalla yhteyttä tuotteen myyneeseen jälleenmyyjään tai paikalliseen ympäristöviranomaiseen. Yrityskäyttäjien tulee ottaa yhteyttä 
tavarantoimittajaan ja selvittää hankintasopimuksen ehdot. Tuotetta tai sen lisävarusteita ei saa hävittää muun kaupallisen jätteen seassa.

[Suomi]

A termék hulladékba helyezésének módszere(WEEE – Elektromos és elektronikus berendezések hulladékai)
Ez a jelzés a terméken, tartozékain vagy dokumentációján arra utal, hogy hasznos élettartama végén a terméket és elektronikus tartozékait 
(pl. töltőegység, fejhallgató, USB kábel) nem szabad a háztartási hulladékkal együtt kidobni. A szabálytalan hulladékba helyezés által 
okozott környezet- és egészségkárosodás megelőzése érdekében ezeket a tárgyakat különítse el a többi hulladéktól, és felelősségteljesen 
gondoskodjon az újrahasznosításukról az anyagi erőforrások fenntartható újrafelhasználásának elősegítése érdekében. A háztartási 
felhasználók a termék forgalmazójától vagy a helyi önkormányzati szervektől kérjenek tanácsot arra vonatkozóan, hová és hogyan vihetik 
el az elhasznált termékeket a környezetvédelmi szempontból biztonságos újrahasznosítás céljából. Az üzleti felhasználók lépjenek 
kapcsolatba beszállítójukkal, és vizsgálják meg az adásvételi szerződés feltételeit. Ezt a terméket és tartozékait nem szabad az egyéb 
közületi hulladékkal együtt kezelni.

[Magyar]

Prawidłowe usuwanie produktu (zużyty sprzęt elektryczny i elektroniczny)
To oznaczenie umieszczone na produkcie, akcesoriach lub dokumentacji oznacza, że po zakończeniu eksploatacji nie należy tego produktu 
ani jego akcesoriów (np. ładowarki, zestawu słuchawkowego, przewodu USB) wyrzucać wraz ze zwykłymi odpadami gospodarstwa 
domowego. Aby uniknąć szkodliwego wpływu na środowisko naturalne i zdrowie ludzi wskutek niekontrolowanego usuwania odpadów, 
prosimy o oddzielenie tych przedmiotów od odpadów innego typu oraz o odpowiedzialny recykling i praktykowanie ponownego 
wykorzystania materiałów. W celu uzyskania informacji na temat miejsca i sposobu bezpiecznego dla środowiska recyklingu tych 
przedmiotów, użytkownicy w gospodarstwach domowych powinni skontaktować się z punktem sprzedaży detalicznej, w którym dokonali 
zakupu produktu, lub z organem władz lokalnych. Użytkownicy w firmach powinni skontaktować się ze swoim dostawcą i sprawdzić warunki 
umowy zakupu. Produktu ani jego akcesoriów nie należy usuwać razem z innymi odpadami komercyjnymi.

[Polski]

Σωστή Απόρριψη αυτού του Προϊόντος (Απόβλητα Ηλεκτρικού & Ηλεκτρονικού Εξοπλισμού) 
(Ισχύει για την Ευρωπαϊκή Ένωση και για άλλες ευρωπαϊκές χώρες με χωριστά συστήματα συλλογής) Αυτό το σήμα που εμφανίζεται επάνω 
στο προϊόν, στα εξαρτήματά του ή στα εγχειρίδια που το συνοδεύουν, υποδεικνύει ότι το προϊόν και τα ηλεκτρονικά του εξαρτήματα (π.χ. 
φορτιστής, ακουστικά, καλώδιο USB) δεν θα πρέπει να ρίπτονται μαζί με τα υπόλοιπα οικιακά απορρίμματα μετά το τέλος του κύκλου ζωής 
τους. Προκειμένου να αποφευχθούν ενδεχόμενες βλαβερές συνέπειες στο περιβάλλον ή την υγεία εξαιτίας της ανεξέλεγκτης διάθεσης 
απορριμμάτων, σας παρακαλούμε να διαχωρίσετε αυτά τα προϊόντα από άλλους τύπους απορριμμάτων και να τα ανακυκλώσετε, ώστε 
να βοηθήσετε στην βιώσιμη επαναχρησιμοποίηση των υλικών πόρων. Οι οικιακοί χρήστες θα πρέπει να έλθουν σε επικοινωνία είτε με 
το κατάστημα απ’ όπου αγόρασαν αυτό το προϊόν, είτε με τις κατά τόπους υπηρεσίες, προκειμένου να πληροφορηθούν τις λεπτομέρειες 
σχετικά με τον τόπο και τον τρόπο με τον οποίο μπορούν να δώσουν αυτά τα προϊόντα για ασφαλή προς το περιβάλλον ανακύκλωση. 
Οι επιχειρήσεις-χρήστες θα πρέπει να έλθουν σε επαφή με τον προμηθευτή τους και να ελέγξουν τους όρους και τις προϋποθέσεις του 
συμβολαίου αγοράς. Αυτό το προϊόν και τα ηλεκτρονικά του εξαρτήματα δεν θα πρέπει να αναμιγνύονται με άλλα συνηθισμένα απορρίμματα 
προς διάθεση.

[Ελληνικά]
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Правилно третиране на изделието след края на експлоатационния му живот
(Отпадъци, представляващи електрическо и електронно оборудване)(Важи за държавите на Европейския съюз и други европейски 
държави със системи за разделно сметосъбиране)
Този знак, поставен върху изделието, негови принадлежности или печатни материали, означава, че продуктът и принадлежностите 
(например зарядно устройство, слушалки, USB кабел) не бива да се изхвърлят заедно с другите битови отпадъци, когато изтече 
експлоатационният му живот. Отделяйте тези устройства от другите видови отпадъци и ги предавайте за рециклиране. Спазвайки 
това правило не излагате на опасност здравето на други хора и предпазвате околната среда от замърсяване, предизвикано от 
безконтролно изхвърляне на отпадъци. Освен това, подобно отговорно поведение създава възможност за повторно (екологично 
съобразно) използване на материалните ресурси. Домашните потребители трябва да се свържат с търговеца на дребно, от когото 
са закупили изделието, или със съответната местна държавна агенция, за да получат подробни инструкции къде и кога могат 
да занесат тези устройства за рециклиране, безопасно за околната среда. Корпоративните потребители следва да се свържат с 
доставчика си и да проверят условията на договора за покупка. Това изделие и неговите електронни принадлежности не бива да се 
сместват с другите отпадъци на търговското предприятие.

[Български]

Správná likvidace výrobku (Elektrický a elektronický odpad)
Toto označení na výrobku, jeho příslušenství nebo dokumentaci znamená, že výrobek a jeho elektronické příslušenství (například nabíječku, 
náhlavní sadu, USB kabel) je po skončení životnosti zakázáno likvidovat jako běžný komunální odpad. Možným negativním dopadům na 
životní prostředí nebo lidské zdraví způsobeným nekontrolovanou likvidací zabráníte oddělením zmíněných produktů od ostatních typů 
odpadu a jejich zodpovědnou recyklací za účelem udržitelného využívání druhotných surovin. Uživatelé z řad domácností by si měli od 
prodejce, u něhož produkt zakoupili, nebo u příslušného městského úřadu vyžádat informace, kde a jak mohou tyto výrobky odevzdat k 
bezpečné ekologické recyklaci. Podnikoví uživatelé by měli kontaktovat dodavatele a zkontrolovat všechny podmínky kupní smlouvy. Tento 
výrobek a jeho elektronické příslušenství nesmí být likvidován spolu s ostatním průmyslovým odpadem.

[Čeština]

Správna likvidácia tohoto výrobku (Elektrotechnický a elektronický odpad) 
(Platné pre Európsku úniu a ostatné európske krajiny so systémom triedeného odpadu)
Toto označenie na výrobku, príslušenstve alebo v sprievodnej brožúre hovorí, že po skončení životnosti by produkt ani jeho elektronické 
príslušenstvo (napr. nabíjačka, náhlavná súprava, USB kábel) nemali byť likvidované s ostatným domovým odpadom. Prípadnému 
poškodeniu životného prostredia alebo ľudského zdravia môžete predísť tým, že budete tieto výrobky oddeľovať od ostatného odpadu a 
vrátite ich na recykláciu. Používatelia v domácnostiach by pre podrobné informácie, ako ekologicky bezpečne naložiť s týmito výrobkami, 
mali kontaktovať buď predajcu, ktorý im ich predal, alebo príslušný úrad v mieste ich bydliska. Priemyselní používatelia by mali kontaktovať 
svojho dodávateľa a preveriť si podmienky kúpnej zmluvy. Tento výrobok a ani jeho elektronické príslušenstvo by nemali byť likvidované 
spolu s ostatným priemyselným odpadom.

[Slovensky]

Cum se elimină corect acest produs (Deşeuri de echipamente electrice şi electronice) 
(Aplicabil în ţările Uniunii Europene şi în alte ţări cu sisteme de colectare selectivă)
Acest simbol de pe produs, accesorii şi documentaţie indică faptul că produsul şi accesoriile sale electronice (încărcător, căşti, cablu USB) 
nu trebuie eliminate împreună cu alte deşeuri menajere la finalul duratei lor de utilizare. Dat fiind că eliminarea necontrolată a deşeurilor 
poate dăuna mediului înconjurător sau sănătăţii umane, vă rugăm să separaţi aceste articole de alte tipuri de deşeuri şi să le reciclaţi în 
mod responsabil, promovând astfel reutilizarea durabilă a resurselor materiale. Utilizatorii casnici trebuie să-l contacteze pe distribuitorul 
care le-a vândut produsul sau să se intereseze la autorităţile locale unde şi cum pot să ducă aceste articole pentru a fi reciclate în mod 
ecologic. Utilizatorii comerciali trebuie să-şi contacteze furnizorul şi să consulte termenii şi condiţiile din contractul de achiziţie. Acest produs 
şi accesoriile sale electronice nu trebuie eliminate împreună cu alte deşeuri comerciale.

[Română]

Izstrādājuma pareiza likvidēšana (Attiecas uz nolietotām elektriskām un elektroniskām ierīcēm) 
(Spēkā Eiropas Savienībā un pārējās Eiropas valstīs, kas izmanto atkritumu dalītu savākšanu)
Šis uz izstrādājuma un tā piederumiem vai pievienotajā dokumentācijā izvietotais marķējums norāda, ka izstrādājumu un tā elektroniskos 
piederumus (piem., uzlādes ierīci, austiņas, USB kabeli) pēc ekspluatācijas laika beigām nedrīkst likvidēt kopā ar citiem sadzīves 
atkritumiem. Lai nepieļautu atkritumu nekontrolētas likvidēšanas radītu varbūtēju kaitējumu videi un cilvēku veselībai, lūdzam minētās ierīces 
nošķirt no citiem atkritumiem un disciplinēti nodot pienācīgai pārstrādei, tā sekmējot materiālo resursu atkārtotu izmantošanu. Lai uzzinātu, 
kur un kā minētās ierīces iespējams nodot ekoloģiski drošai pārstrādei, mājsaimniecībām jāsazinās ar izstrādājuma pārdevēju vai savu 
pašvaldību. Iestādēm un uzņēmumiem jāsazinās ar izstrādājuma piegādātāju un jāiepazīstas ar pirkuma līguma nosacījumiem. Izstrādājumu 
un tā elektroniskos piederumus nedrīkst nodot likvidēšanai kopā ar citiem iestāžu un uzņēmumu atkritumiem.

[Latviešu]

Tinkamas šio gaminio išmetimas (elektros ir elektroninės įrangos atliekos)
Šis ženklas, pateiktas ant gaminio, jo priedų ar dokumentacijoje, nurodo, kad gaminio ir jo elektroninių priedų (pvz., įkroviklio, ausinių, 
USB kabelio) negalima išmesti kartu su kitomis buitinėmis atliekomis gaminio naudojimo laikui pasibaigus. Kad būtų išvengta galimos 
nekontroliuojamo atliekų išmetimo žalos aplinkai arba žmonių sveikatai ir skatinamas aplinką tausojantis antrinių žaliavų panaudojimas, 
atskirkite šiuos elementus nuo kitų rūšių atliekų ir atiduokite perdirbti. Informacijos kur ir kaip pristatyti šiuos elementus saugiai perdirbti, 
privatūs vartotojai turėtų kreiptis į parduotuvę, kurioje šį gaminį pirko, arba į vietos valdžios institucijas. Verslo vartotojai turėtų kreiptis 
į savo tiekėją ir peržiūrėti pirkimo sutarties sąlygas. Tvarkant atliekas, šio gaminio ir jo elektroninių priedų negalima maišyti su kitomis 
pramoninėmis atliekomis.

[Lietuvių]
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Õige viis toote kasutuselt kõrvaldamiseks (elektriliste ja elektrooniliste seadmete jäätmed)
Selline tähistus tootel või selle tarvikutel või dokumentidel näitab, et toodet ega selle elektroonilisi tarvikuid (nt laadija, peakomplekt, USB-
kaabel) ei tohi kasutusaja lõppemisel kõrvaldada koos muude olmejäätmetega. Selleks et vältida jäätmete kontrollimatu kõrvaldamisega 
seotud võimaliku kahju tekitamist keskkonnale või inimeste tervisele ning edendada materiaalsete vahendite säästvat taaskasutust, 
eraldage need esemed muudest jäätmetest ja suunake need vastutustundlikult taasringlusse. Kodukasutajad saavad teavet nende esemete 
keskkonnaohutu ringlussevõtu kohta kas toote müüjalt või keskkonnaametist. Firmad peaksid võtma ühendust tarnijaga ning kontrollima 
ostulepingu tingimusi ja sätteid. Toodet ega selle elektroonilisi tarvikuid ei tohi panna muude hävitamiseks mõeldud kaubandusjäätmete 
hulka.

[Eesti]
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Correct disposal of batteries in this product 
(Applicable in the European Union and other European countries with separate battery return systems.) 
This marking on the battery, manual or packaging indicates that the batteries in this product should not be disposed of with other household 
waste at the end of their working life. Where marked, the chemical symbols Hg, Cd or Pb indicate that the battery contains mercury, cadmium 
or lead above the reference levels in EC Directive 2006/66. If batteries are not properly disposed of, these substances can cause harm to 
human health or the environment. To protect natural resources and to promote material reuse, please separate batteries from other types of 
waste and recycle them through your local, free battery return system.

[English]
Elimination des batteries de ce produit 
(Applicable aux pays de l’Union européenne et aux autres pays européens dans lesquels des systèmes de collecte sélective sont mis en 
place.)
Le symbole sur la batterie, le manuel ou l’emballage indique que les batteries de ce produit ne doivent pas être éliminées en fin de vie avec 
les autres déchets ménagers. L’indication éventuelle des symboles chimiques Hg, Cd ou Pb signifie que la batterie contient des quantités de 
mercure, de cadmium ou de plomb supérieures aux niveaux de référence stipulés dans la directive CE 2006/66. Si les batteries ne sont pas 
correctement éliminées, ces substances peuvent porter préjudice à la santé humaine ou à l’environnement. Afin de protéger les ressources 
naturelles et d’encourager la réutilisation du matériel, veillez à séparer les batteries des autres types de déchets et à les recycler via votre 
système local de collecte gratuite des batteries.

[Français]
Korrekte Entsorgung der Batterien dieses Produkts 
(In den Ländern der Europäischen Union und anderen europäischen Ländern mit einem separaten Altbatterie-Rücknahmesystem)
Die Kennzeichnung auf der Batterie bzw. auf der dazugehörigen Dokumentation oder Verpackung gibt an, dass die Batterie zu diesem 
Produkt nach seiner Lebensdauer nicht zusammen mit dem normalen Haushaltsmüll entsorgt werden darf. Wenn die Batterie mit den 
chemischen Symbolen Hg, Cd oder Pb gekennzeichnet ist, liegt der Quecksilber-, Cadmium- oder Blei-Gehalt der Batterie über den in der 
EG-Richtlinie 2006/66 festgelegten Referenzwerten. Wenn Batterien nicht ordnungsgemäß entsorgt werden, können sie der menschlichen 
Gesundheit bzw. der Umwelt schaden. Bitte helfen Sie, die natürlichen Ressourcen zu schützen und die nachhaltige Wiederverwertung 
von stofflichen Ressourcen zu fördern, indem Sie die Batterien von anderen Abfällen getrennt über Ihr örtliches kostenloses Altbatterie-
Rücknahmesystem entsorgen.

[Deutsch]
Correcte behandeling van een gebruikte accu uit dit product
(Van toepassing op de Europese Unie en andere Europese landen met afzonderlijke inzamelingssystemen voor accu’s en batterijen.)
Dit merkteken op de accu, handleiding of verpakking geeft aan dat de accu in dit product aan het einde van de levensduur niet samen met 
ander huishoudelijk afval mag worden weggegooid. De chemische symbolen Hg, Cd of Pb geven aan dat het kwik-, cadmium- of loodgehalte 
in de accu hoger is dan de referentieniveaus in de Richtlijn 2006/66/EC. Indien de gebruikte accu niet op de juiste wijze wordt behandeld, 
kunnen deze stoffen schadelijk zijn voor de gezondheid van mensen of het milieu. Ter bescherming van de natuurlijke hulpbronnen en ter 
bevordering van het hergebruik van materialen, verzoeken wij u afgedankte accu’s en batterijen te scheiden van andere soorten afval en 
voor recycling aan te bieden bij het gratis inzamelingssysteem voor accu’s en batterijen in uw omgeving.

[Nederlands]
Corretto smaltimento delle batterie del prodotto
(Applicabile nei paesi dell’Unione Europea e in altri paesi europei con sistemi di conferimento differenziato delle batterie.)  
Il marchio riportato sulla batteria o sulla sua documentazione o confezione indica che le batterie di questo prodotto non devono essere 
smaltite con altri rifiuti domestici al termine del ciclo di vita. Dove raffigurati, i simboli chimici Hg, Cd o Pb indicano che la batteria contiene 
mercurio, cadmio o piombo in quantità superiori ai livelli di riferimento della direttiva UE 2006/66. Se le batterie non vengono smaltite 
correttamente, queste sostanze possono causare danni alla salute umana o all’ambiente. Per proteggere le risorse naturali e favorire il 
riutilizzo dei materiali, separare le batterie dagli altri tipi di rifiuti e riciclarle utilizzando il sistema di conferimento gratuito previsto nella propria 
area di residenza.

[Italiano]
Eliminación correcta de las baterías de este producto
(Aplicable en la Unión Europea y en otros países europeos con sistemas de recogida selectiva de baterías.)  
La presencia de esta marca en las baterías, el manual o el paquete del producto indica que cuando haya finalizado la vida útil de las 
baterías no deberán eliminarse junto con otros residuos domésticos. Los símbolos químicos Hg, Cd o Pb, si aparecen, indican que la batería 
contiene mercurio, cadmio o plomo en niveles superiores a los valores de referencia admitidos por la Directiva 2006/66 de la Unión Europea. 
Si las baterías no se desechan convenientemente, estas sustancias podrían provocar lesiones personales o dañar el medioambiente. Para 
proteger los recursos naturales y promover el reciclaje, separe las baterías de los demás residuos y recíclelas mediante el sistema de 
recogida gratuito de su localidad.

[Español]
Eliminação correcta das baterias existentes neste produto
(Aplicável na União Europeia e noutros países europeus com sistemas de recolha de baterias separados.)
Esta marca, apresentada na bateria, manual ou embalagem, indica que as baterias existentes neste produto não devem ser eliminadas 
juntamente com os resíduos domésticos indiferenciados no final do seu período de vida útil. Onde existentes, os símbolos químicos Hg, Cd 
ou Pb indicam que a bateria contém mercúrio, cádmio ou chumbo acima dos níveis de referência indicados na Directiva CE 2006/66. Se as 
baterias não forem correctamente eliminadas, estas substâncias poderão ser prejudiciais para a saúde humana ou para o meio ambiente. 
Para proteger os recursos naturais e promover a reutilização dos materiais, separe as baterias dos outros tipos de resíduos e recicle-as 
através do sistema gratuito de recolha local de baterias.

[Português]
Ustrezno odstranjevanje baterij v tem izdelku
(Uporabno v EU in ostalih evropskih državah s sistemi ločenega odstranjevanja baterij)
Ta oznaka na bateriji, v navodilih ali na embalaži pomeni, da baterij ob izteku njihove življenjske dobe v tem izdelku ne smete odstraniti 
skupaj z ostalimi gospodinjskimi odpadki. Oznake za kemijske elemente Hg, Cd ali Pb pomenijo, da baterija vsebuje živo srebro, kadmij ali 
svinec v količinah, ki presegajo referenčne nivoje v direktivi EC 2006/66. Če te baterije niso ustrezno odstranjene, te snovi lahko škodujejo 
zdravju ljudi oziroma okolju. Za zaščito naravnih virov in za vzpodbujanje ponovne uporabe materialov prosimo, ločite te baterije od ostalih 
odpadkov in jih oddajte na predvidenih lokalnih zbirnih reciklažnih mestih.

[Slovenščina]
Korrekt avfallshantering av batterierna i denna produkt
(Gäller EU och andra europeiska länder med särskild batteriåtervinning.) Denna markering på batteriet, i manualen eller på förpackningen 
anger att batterierna i denna produkt inte bör slängas tillsammans med annat hushållsavfall. De kemiska symbolerna Hg, Cd eller Pb 
visar i förekommande fall att batterierna innehåller kvicksilver, kadmium eller bly i mängder överstigande de gränsvärden som anges i 
EU-direktivet 2006/66. Om batterierna inte slängs på ett ansvarsfullt sätt kan dessa substanser utgöra en fara för hälsa eller miljö. Hjälp till 
att skydda naturresurser och bidra till materialåtervinning genom att sortera batterierna separat från annat avfall och lämna in dem på en 
återvinningsstation.

[Svenska]
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KKorrekt bortskaffelse af batterierne i dette produkt
(Gælder i EU og andre europæiske lande med særlige retursystemer for batterier).
Mærket på dette batteri, dokumentationen eller emballagen betyder, at batterierne i dette produkt efter endt levetid ikke må bortskaffes 
sammen med andet husholdningsaffald. Mærkning med de kemiske symboler Hg, Cd eller Pb betyder, at batteriet indeholder kviksølv, 
cadmium eller bly over grænseværdierne i EU-direktiv 2006/66. Hvis batterierne ikke bortskaffes korrekt, kan disse stoffer være skadelige 
for menneskers helbred eller for miljøet. For at beskytte naturens ressourcer og fremme genbrug, skal batterier holdes adskilt fra andre typer 
affald og genanvendes via dit lokale, gratis batteriretursystem.

[Dansk]

Korrekt avhending av batterier i dette produkt
(Kommer til anvendelse i Den europeiske union og i andre europeiske land med separate systemer for retur av batterier.)
Denne merkingen på batteriet, håndboken eller emballasjen angir at batteriene i dette produktet ikke skal kastes sammen med annet 
husholdningsavfall ved slutten av sin levetid. Der det er merket, angir de kjemiske symbolene Hg, Cd eller Pb at batteriet inneholder 
kvikksølv, kadmium eller bly over referansenivåene i EF-direktiv 2006/66. Hvis batteriene ikke avhendes på riktig måte, kan disse stoffene 
skade menneskers helse eller miljøet. For å beskytte naturressurser og for å fremme gjenbruk av materialer, ber vi deg adskille batterier fra 
andre typer avfall og resirkulere dem ved å levere dem på din lokale, gratis mottaksstasjon.

[Norsk]

Tuotteen paristojen oikea hävittäminen
(Koskee Euroopan Unionia ja muita Euroopan maita, joissa on erillinen paristojen palautusjärjestelmä.)
Pariston, käyttöoppaan tai pakkauksen tämä merkintä tarkoittaa, että tämän tuotteen sisältämiä paristoja ei saa hävittää muun 
kotitalousjätteen seassa, kun niiden käyttöikä on päättynyt. Kemiallinen symboli Hg, Cd tai Pb ilmaisee, että paristo sisältää elohopeaa, 
kadmiumia tai lyijyä ylin EU: n direktiivien 2006/66 viiterajojen. Jos paristoja ei hävitetä oikein, nämä aineet voivat vahingoittaa ihmisten 
terveyttä tai ympäristöä. Suojaa luonnonvaroja ja edistä materiaalien uusiokäyttöä - erottele paristot muusta jätteestä ja toimita ne 
kierrätettäväksi paikalliseen maksuttomaan paristojen palautusjärjestelmään.

[Suomi]

A termékhez tartozó akkumulátorok megfelelő ártalmatlanítása
(Az Európai Unió területén és más, önálló akkumulátorleadó rendszerrel rendelkező európai országok területén alkalmazandó.)
Az akkumulátoron, a kézikönyvön vagy a csomagoláson szereplő jelzés arra utal, hogy hasznos élettartama végén a terméket nem 
szabad egyéb háztartási hulladékkal együtt kidobni. Ahol szerepel a jelzés, a Hg, Cd vagy Pb kémiai elemjelölések arra utalnak, hogy 
az akkumulátor az EK 2006/66. számú irányelvben rögzített referenciaszintet meghaladó mennyiségű higanyt, kadmiumot vagy ólmot 
tartalmaz. Az akkumulátorok nem megfelelő kezelése esetén ezek az anyagok veszélyt jelenthetnek az egészségre vagy a környezetre. 
A természeti erőforrások megóvása és az anyagok újrafelhasználásának ösztönzése érdekében kérjük, különítse el az akkumulátorokat a 
többi hulladéktól és vigye vissza a helyi, ingyenes akkumulátorleadó helyre.

[Magyar]

Sposób poprawnego usuwania baterii, w które wyposażony jest niniejszy produkt
(Dotyczy obszaru Unii Europejskiej oraz innych krajów europejskich posiadających oddzielne systemy zwrotu zużytych baterii.)
Niniejsze oznaczenie na baterii, instrukcji obsługi lub opakowaniu oznacza, że po upływie okresu użytkowania baterie, w które wyposażony 
był dany produkt, nie mogą zostać usunięte wraz z innymi odpadami pochodzącymi z gospodarstw domowych. Przy zastosowaniu takiego 
oznaczenia symbole chemiczne (Hg, Cd lub Pb) wskazują, że dana bateria zawiera rtęć, kadm lub ołów w ilości przewyższającej poziomy 
odniesienia opisane w dyrektywie WE 2006/66. Jeśli baterie nie zostaną poprawnie zutylizowane, substancje te mogą powodować 
zagrożenie dla zdrowia ludzkiego lub środowiska naturalnego. Aby chronić zasoby naturalne i promować ponowne wykorzystanie 
materiałów, należy oddzielać baterie od innego typu odpadów i poddawać je utylizacji poprzez lokalny, bezpłatny system zwrotu baterii.

[Polski]

Σωστή απόρριψη των μπαταριών αυτού του προϊόντος 
(Ισχύει στην Ευρωπαϊκή Ένωση και άλλες ευρωπαϊκές χώρες με συστήματα ξεχωριστής ανακύκλωσης μπαταριών.)
Αυτή η επισήμανση πάνω στη μπαταρία, το εγχειρίδιο ή τη συσκευασία υποδεικνύει ότι οι μπαταρίες αυτού του προϊόντος δεν πρέπει να 
απορρίπτονται μαζί με άλλα οικιακά απορρίμματα στο τέλος του κύκλου ζωής τους. Όπου υπάρχουν, τα χημικά σύμβολα Hg, Cd ή Pb 
υποδεικνύουν ότι η μπαταρία περιέχει υδράργυρο, κάδμιο ή μόλυβδο πάνω από τα επίπεδα αναφοράς της Ευρωπαϊκής Οδηγίας 2006/66. 
Αν οι μπαταρίες δεν απορριφθούν σωστά, αυτές οι ουσίες ενδέχεται να προκαλέσουν βλαβερές συνέπειες στην ανθρώπινη υγεία ή το 
περιβάλλον. Παρακαλούμε διαχωρίζετε τις μπαταρίες από άλλους τύπους απορριμμάτων και ανακυκλώνετέ τις μέσω του τοπικού σας, 
δωρεάν συστήματος ανακύκλωσης μπαταριών, για την προστασία των φυσικών πόρων και την προώθηση της επαναχρησιμοποίησης 
υλικών.

[Ελληνικά]

Правилно изхвърляне на батериите в този продукт
(Приложимо в Европейския съюз и други европейски държави със самостоятелни системи за връщане на батерии.)
Това обозначение върху батерията, ръководството или опаковката, показва, че батериите в този продукт не бива да се изхвърлят 
с другите битови отпадъци в края на техния полезен живот. Където са маркирани, химическите символи Hg, Cd или Pb показват, 
че батерията съдържа живак, кадмий или олово над контролните нива в Директива 2006/66 на ЕО. Ако батериите не се изхвърлят 
правилно, тези вещества могат да предизвикат увреждане на човешкото здраве или на околната среда. За да предпазите 
природните ресурси и за да съдействате за многократната употреба на материалните ресурси, моля отделяйте батериите от 
другите видове отпадъчни продукти и ги рециклирайте посредством Вашата локална система за безплатно връщане на батерии.

[Български]
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Správná likvidace baterií v tomto výrobku
(Platí v Evropské unii a dalších evropských zemích s vlastními systémy zpětného odběru baterií.)
Tato značka na baterii, návodu nebo obalu znamená, že baterie v tomto výrobku nesmí být na konci své životnosti likvidovány společně s 
jiným domovním odpadem. Případně vyznačené symboly chemikálií Hg, Cd nebo Pb upozorňují na to, že baterie obsahuje rtuť, kadmium 
nebo olovo v množství překračujícím referenční úrovně stanovené směrnicí ES 2006/66. Pokud baterie nejsou správně zlikvidovány, mohou 
tyto látky poškodit zdraví osob nebo životní prostředí. Pro ochranu přírodních zdrojů a pro podporu opakovaného využívání materiálů 
oddělte, prosím, baterie od ostatních typů odpadu a nechte je recyklovat prostřednictvím místního bezplatného systému zpětného odběru 
baterií.

[Čeština]

Správna likvidácia batérií v tomto výrobku 
(Aplikovateľné v krajinách Európskej únie a v ostatných európskych krajinách, v ktorých existujú systémy separovaného zberu batérií.)
Toto označenie na batérii, príručke alebo balení hovorí, že batérie v tomto výrobku by sa po skončení ich životnosti nemali likvidovať spolu 
s ostatným domovým odpadom. V prípade takéhoto označenia chemické symboly Hg, Cd alebo Pb znamenajú, že batéria obsahuje ortuť, 
kadmium alebo olovo v množstve presahujúcom referenčné hodnoty smernice 2006/66/ES. Pri nevhodnej likvidácii batérií môžu tieto látky 
poškodiť zdravie alebo životné prostredie. Za účelom ochrany prírodných zdrojov a podpory opätovného použitia materiálu batérie likvidujte 
oddelene od iných typov odpadou a recyklujte ich prostredníctvom miestneho systému bezplatného zberu batérií.

[Slovensky]

Dispoziţii privind eliminarea corectă a bateriilor acestui produs 
(aplicabile în Uniunea Europeană şi în alte ţări europene cu sisteme separate de colectare a bateriilor)
Acest marcaj de pe baterie, de pe manualul de utilizare sau de pe ambalaj indică faptul că bateriile acestui produs nu trebuie eliminate 
împreună cu alte deşeuri menajere la sfârşitul ciclului lor de viaţă. Dacă sunt marcate, simbolurile chimice Hg, Cd sau Pb indică faptul că 
bateria conţine mercur, cadmiu sau plumb peste nivelurile de referinţă prevăzute în Directiva CE 2006/66. În cazul în care bateriile nu sunt 
eliminate corespunzător, aceste substanţe pot fi dăunătoare pentru sănătatea omului sau pentru mediu. În vederea protejării resurselor 
naturale şi a promovării refolosirii materialelor, vă rugăm să separaţi bateriile de celelalte tipuri de deşeuri şi să le reciclaţi prin intermediul 
sistemului gratuit de returnare a bateriilor la nivel local.

[Română]

Šī izstrādājuma bateriju pareiza utilizācija
(Piemērojama Eiropas Savienībā un citās Eiropas valstīs ar atsevišķām bateriju nodošanas sistēmām.)
Šis marķējums uz baterijas, rokasgrāmatā vai uz iepakojuma norāda, ka šī izstrādājuma bateriju pēc tās kalpošanas laika beigām nedrīkst 
izmest ar citiem sadzīves atkritumiem. Ja uz baterijas ir atzīmēti ķīmiskie simboli, piem., Hg, Cd vai Pb, tie norāda, ka baterija satur 
dzīvsudrabu, kadmiju vai svinu, kura saturs ir lielāks par EK Direktīvā 2006/66 minētajiem lielumiem. Ja baterijas tiek nepareizi likvidētas, šīs 
vielas var radīt kaitējumu cilvēku veselībai vai videi. Lai aizsargātu dabas resursus un veicinātu materiālu otrreizēju izmantošanu, šķirojiet 
baterijas atsevišķi no citiem atkritumu veidiem un nododiet tās otrreizējai pārstrādei, izmantojot bateriju vietējo bezmaksas nodošanas 
sistēmu.

[Lietuvių]

Tinkamas šio produkto akumuliatorių tvarkymas
(Taikoma Europos Sąjungoje ir kitose Europos šalyse, kuriose galioja atskiros akumuliatorių grąžinimo sistemos.)
Šis ženklas yra pateikiamas ant akumuliatoriaus, jo dokumentacijoje ar ant pakuotės nurodo, kad šio produkto akumuliatorių, pasibaigus 
jų tarnavimo laikui, negalima išmesti kartu su kitomis buitinėmis atliekomis. Cheminiai simboliai Hg, Cd arba Pb rodo, kad akumuliatoriuje 
yra gyvsidabrio, kadmio ar švino, kurio kiekis viršija normą, nurodytą ES direktyvoje 2006/66. Jei akumuliatoriai nebus tinkamai išmesti, 
šios medžiagos gali sukelti žalos žmonių sveikatai ar aplinkai. Tam, kad būtų apsaugoti gamtos ištekliai ir skatinamas antrinių žaliavų 
panaudojimas, pašome atskirti akumuliatorių nuo kitų rūšių atliekų ir atiduoti perdirbti vietinėje akumuliatorių grąžinimo sistemai.

[Lietuvių]

Őige viis toote akude kasutusest kőrvaldamiseks
(Rakendatav Euroopa Liidus ja teistes Euroopa riikides, kus on kasutusel spetsiaalsed akude kogumissüsteemid).
Selline tähistus akul, dokumentidel vői pakendil näitab, et toote akusid ei tohi kasutusaja lőppemisel kőrvaldada koos muude 
olmejäätmetega. Keemilised elemendid Hg, Cd, vői Pb näitavad, et aku elavhőbeda, kaadmiumi vői plii sisaldus on EÜ direktiivi 2006/66 
sihttasemest suurem. Kui akusid ei kőrvaldata őigel viisil, vőib nende sisu pőhjustada tervise-vői keskkonnakahjustusi. Selleks, et kaitsta 
loodusvarasid ja edendada materjalide taaskasutamist, eraldage akud muudest jäätmetest ja suunake need taaskasutusse kohaliku, tasuta 
teenusena pakutava akude tagastussüsteemi abil.

[Eesti]
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